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Introduction
Thank you for purchasing the ScanSnap S500 Color Image Scanner product. 
ScanSnap S500 comes with a color image scanner and office applications. It is a complete Office 
Solution designed to improve your productivity and to solve your office scanning problems. Scan-
Snap product has the following features.

■ Just pressing the Scanner button allows you to turn images on paper into PDFs! 
You can turn the documents that clutter up your desktop into PDFs, and manage and 
archive them on your computer. You can use the Adobe® Acrobat® software packaged 
with this scanner to display these PDF documents. 

ScanSnap product can also automatically recognize the type of document, color or 
black & white, so scanned image files can be made smaller when scanning documents 
containing a mixture of color and black & white pages. You can also have the scanner 
automatically remove blank pages in documents in order to reduce the size of files even 
more.

■ Effortless scanning! 
Double-sided color documents A4 or Letter in size can be scanned at a speed of about 
18 sheets/minute (when Scan mode is set to Normal, Color mode is set to Auto, and 
Compression rate is set to 3). (*1)

■ Small desktop footprint!
Smaller than a sheet of A4 or letter paper in size, ScanSnap scanner can be left on your 
desk all the time. 

■ Business cards easily filed!
Business cards can be easily filed and searched for using the OCR function by using the 
"CardMinder™" software supplied with the scanner.

(*1) -Depending on the document, scanning speed may become slower in "B&W" 
(Black&White) mode (due to process for converting data scanned in color to mono-
chrome data).
Example: Scanning color brochures in "B&W" mode

-When either of "Automatic size and skew detection", or "Automatic image rotation" is 
enabled, scanning speed may become slower.

(*)  ScanSnap S500 does not support TWAIN and ISIS standards.

This document describes how to handle ScanSnap S500 and basic operation methods. Before you 
start using ScanSnap S500 be sure to thoroughly read this manual to ensure correct use. 
ScanSnap S500 is referred to as ScanSnap hereafter in this document.
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■ Regulatory Information

FCC declaration

This equipment has been tested and found to comply with the limits for a Class B digital 
device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide 
reasonable protection against harmful interference in a residential installation. This 
equipment generates, uses, and can radiate radio frequency energy and, if not installed and 
used in accordance with the instruction manual, may cause harmful interference to radio 
communications. However, there is no guarantee that interference will not occur in a 
particular installation. If this equipment does cause harmful interference to radio or 
television reception, which can be determined by turning the equipment off and on, the user 
is encouraged to try to correct the interference by one or more of the following measures:

•Reorient or relocate the receiving antenna.

•Increase the separation between the equipment and receiver.

•Connect the equipment into an outlet on a circuit different from that to which the receiver is 
located.

•Consult your dealer or an experienced radio/TV technician.

FCC warning: Changes or modifications not expressly approved by the party responsible 
for compliance could void the user’s authority to operate the equipment.

Canadian DOC Regulations

This digital apparatus does not exceed the Class B limit for radio noise emissions from 
digital apparatus set out in the Radio interference Regulations of the Canadian Department 
of Communications.
This Class B digital apparatus complies with Canadian ICES-003.

Le pésent appareil numérique n’ément pas de bruits radioélectriques dépassant les limites 
applicables aux appareils numériques de la classe B prescridtes dans le Réglesment sur le 
brouillage radioélectrique dicté par le ministere des Communications du Canada.
Cet appareil numérique de la classe B est conformme à la norme NMB-003 du Canada.

CAUTION
Changes or modifications not expressly approved by the party responsi-
ble for compliance could void the user’s authority to operate the equip-
ment.

ATTENTION
• The use of a shielded interface cable is required to comply with the Class B 

limits of Part 15 of FCC rules. 
• The length of the AC cable must be 3 meters (10 feet) or less.
vi



Bescheinigung des Herstellers / Importeurs

Für den S500 wid folgendes bescheinigt:

•In Übereinsstimmung mit den Bestimmungen der EN45014(CE) funkentstört 

•Maschinenlärminformationsverordnung 3. GPSGV: Der höchste Schalldruckpegel beträgt 
70 dB (A) oder weniger, gemäß EN ISO 7779.

International ENERGY STAR® Program

As an ENERGY STAR® Partner, PFU LIMITED has 
determined that this product meets the ENERGY STAR® 
guidelines for energy efficiency.
The International ENERGY STAR® Office Equipment Program 
is an international program that promotes energy saving through 
the penetration of energy efficient computers and other office 
equipment. The program backs the development and 
dissemination of products with functions that effectively reduce 
energy consumption. It is an open system in which business proprietors can participate 
voluntarily. The targeted products are office equipment such as computers, monitors, 
printers, facsimiles, copiers, scanners, and multifunction devices. Their standards and logos 
are uniform among participating nations.
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■ Note, Liability
READ ALL OF THIS MANUAL CAREFULLY BEFORE USING THIS PRODUCT. IF 
THIS PRODUCT IS NOT USED CORRECTLY, UNEXPECTED INJURY MAY BE 
CAUSED TO USERS OR BYSTANDERS.

While all efforts have been made to ensure the accuracy of all information in this manual, 
PFU assumes no liability to any party for any damage caused by errors or omissions or by 
statements of any kind in this manual, its updates or supplements, whether such errors are 
omissions or statements resulting from negligence, accidents, or any other cause. PFU 
further assumes no liability arising from the application or use of any product or system 
described herein; nor any liability for incidental or consequential damages arising from the 
use of this manual. PFU disclaims all warranties regarding the information contained herein, 
whether expressed, implied, or statutory.

Use in High-safety Applications

This product has been designed and manufactured on the assumption that it will be used in 
office, personal, domestic, regular industrial, and general-purpose applications. It has not 
been designed and manufactured for use in applications (simply called "high-safety 
applications" from here on) that directly involve danger to life and health when a high degree 
of safety is required, for example, in the control of nuclear reactions at nuclear power 
facilities, automatic flight control of aircraft, air traffic control, operation control in mass-
transport systems, medical equipment for sustaining life, and missile firing control in 
weapons systems, and when provisionally the safety in question is not ensured. The user 
should use this product with adopting measures for ensuring safety in such high-safety 
applications. PFU LIMITED assumes no liability whatsoever for damages arising from use 
of this product by the user in high-safety applications, and for any claims or compensation 
for damages by the user or a third party.

About the use of mercury

To avoid unexpected injury, read the following carefully. 
Doing the following actions may result in serious personal injuries: 

•Do not put the substance in the lamp in your mouth as it contains mercury.

•Do not incinerate, crush, or shred the scanner.

•Do not breathe the chemical liquid contained in the scanner parts.

Lamp(s) inside this product contain mercury and must be recycled or dis-
posed of according to local, state, or federal laws. Hg
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■ Trademarks
ScanSnap, ScanSnap logo, and CardMinder are the trademarks of PFU LIMITED.
Microsoft, Windows, and Windows NT are registered trademarks of Microsoft Corporation 
in the United States and/or other countries. 
Adobe, the Adobe logo, and Acrobat are either registered trademarks of Adobe Systems 
Incorporated in the United States and/or other countries.
Other product names are the trademarks or registered trademarks of the respective 
companies.

ABBYY™ FineReader™ 7.x Engine © ABBYY Software House 2005.
OCR by ABBYY Software House. All rights reserved.
ABBYY, FineReader are trademarks of ABBYY Software House.

How Trademarks Are Indicated In This Manual

ScanSnap: ScanSnap S500
CardMinder: CardMinder™ 3.0
References to operating systems (OS) are indicated as follows:
Windows 98: Microsoft® Windows® 98 operating system.
Windows Me: Microsoft® Windows® Millennium Edition operating system.
Windows 2000: Microsoft® Windows® 2000 Professional operating system.
Windows XP: Microsoft® Windows® XP Professional operating system,

Microsoft® Windows® XP Home Edition operating system.
Where there is no distinction between the different versions of the above operating 
system, the general term "Windows" is used.

Adobe Acrobat 7.0: Adobe® Acrobat® 7.0 Standard.
Where there is no distinction between the different versions of the above application, the 
general term "Adobe Acrobat" is used.

ABBYY FineReader: ABBYYTM FineReaderTM for ScanSnap.

Manufacturer

PFU LIMITED
International Sales Dept., Imaging Business Division, Products Group 
Solid Square East Tower, 580 Horikawa-cho, Saiwai-ku, Kawasaki-shi Kanagawa 212-8563, Japan
Phone : (81-44) 540-4538

All Rights Reserved, Copyright©  PFU LIMITED 2006.
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■ Safety Precautions
This manual describes important details for ensuring the safe and correct use of this product. 
Thoroughly read this manual before you start to use this product. In particular, be sure to 
read and fully understand the Safety Precautions described in this manual before you use this 
product.
Also, store this manual in a safe place so that it can be easily referred to during use of this 
product.

Warning Indications Used In This Manual

This manual uses the following indications to ensure safe and correct use of this product, and 
to prevent possible danger and injury to the operator and other persons.

Symbols Used In This Manual

This manual uses the following symbols in explanations in addition to warning indications. 

WARNING
This indication alerts operators to an operation that, if not strictly 
observed, may result in severe injury or death.

CAUTION
This indication alerts operators to an operation that, if not strictly 
observed, may result in safety hazards to personnel or damage to 
equipment.

ATTENTION
This symbol alerts operators to particularly important information. Be sure to 
read this information.

HINT

This symbol alerts operators to helpful advice regarding operation.

Operation This symbol shows operation with your computer. 

Operation This symbol shows operation with your scanner. 
x



About the Warning Label

This product carries the following label warning.

Screen Examples In This Manual

The screen examples in this manual are subject to change without notice in the interest of 
product improvement.
If the screen differs from the screen examples in this manual, operate by following the screen 
while referring to the User's Manual of the scanner.
Furthermore, the screenshots in this manual are for the ScanSnap Manager and the 
CardMinder application.
The screen examples in this manual are created according to Microsoft Corporation’s 
Guideline.

About Maintenance

The user must not perform repairs on this scanner.
Contact the store where you purchased the scanner or an authorized FUJITSU Image 
Scanner service provider to make for repairs to this product.

A TRIANGLE symbol indicates that special care and attention is required.
The drawing inside the triangle shows the specific caution. 

A CIRCLE with a diagonal line inside shows action which users may not perform.
The drawing inside or under the circle shows the specific action that is not 
allowed.

R
Outline characters on a colored background show instructions users should fol-
low. 
It may also include the drawing that shows the specific instruction.

The surrounding area where this warning label is affixed can become very hot.  
Please take serious caution as the heat can cause burns.

ATTENTION

Do NOT remove from the scanner, stain or scratch the warning labels.
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WARNING

The following describes important warnings described in this manual.

Do not touch the AC cable with wet hands.

Do not damage the AC cable.

Use only specified AC cable, AC adapter and connector cables

Use this scanner only at the indicated power voltage. Do not 
connect to multiple-power strips.

Wipe any dust from the power plug.

Do not install in locations subject to oil smoke, steam, humidity, 
and dust.

Do not touch the power plug with wet hands. Doing so might cause electric 
shock.

A damaged AC cable may cause fire or electric shock.
Do not place heavy objects on AC cables, or pull, bend, twist, heat, damage or 
modify AC cables.
Do not use damaged AC cables or power plugs, and AC cables or power plugs 
when the wall socket is loose.

Use only specified AC cables and connector cables. Failure to use the correct 
cables might cause electric shock and equipment failure.
Do not use the AC cable provided with this scanner for other devices, since this 
might cause equipment failure and other troubles or an electric shock.

Use this scanner only at the indicated power voltage and current. Improper 
power voltage and current might cause fire or electric shock.
Also, do not connect to multiple-power strips.

Wipe off any dust from metal parts on the power plug or metal fittings with a soft, 
dry cloth. Accumulated dust might cause fire or electric shock.

Do not install the scanner in locations subject to oil smoke, steam, humidity, and 
dust. Doing so might cause a fire or electric shock.
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Do not use the scanner if you smell strange odor.

Turn the scanner OFF if it is damaged.

Do not put liquids inside the scanner.

Do not touch the inside of the scanner unless necessary.

If you detect heat coming from the device or detect other problems such as 
smoke, strange smells or noises, immediately turn off the scanner and then 
disconnect its power plug.
Make sure that the smoking has stopped, and then contact the store where you 
bought the scanner or an authorized FUJITSU scanner service provider.

If the scanner is damaged for any reason, turn off the scanner and unplug the 
power cable before contacting the store where you purchased the scanner.

• Do not insert or drop metal objects in to the scanner.
• Do not scan wet documents or documents with paper clips or staples.
• Do not splash or allow the scanner to get wet.

If foreign objects (water, small metal objects, liquids, etc.) get inside the scanner, 
immediately turn off the scanner and disconnect the power plug from the power 
outlet, then contact the store where you bought the scanner or the Maintenance 
Service Center. 
Pay particular attention to this warning in households where there are small chil-
dren.

Do not take apart or modify the scanner. The inside of the scanner contains high-
voltage components. Touching these components might cause fire or electric 
shock.
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CAUTION

The following illustrates important cautions described in this manual.

Do not install the scanner on unstable surfaces.

Firmly insert the power plug.

Do not block the ventilation ports.

Do not place heavy objects or climb on top of the scanner.

Before moving the scanner, unplug the power cord from the 
electrical outlet.

Install the scanner on a flat, lever surface. Make sure none of the scanner parts 
protrude outside the desktop. Make sure that the scanner is installed on a flat, 
level surface.
Do not install the scanner on unstable surfaces. Install the scanner on a level 
surface that is free of vibration to prevent it from falling.
Install the scanner on a strong surface that will support the weight of the scanner 
and other devices.

Firmly insert the power plug into the power outlet as far it can go.

Do not block the ventilation ports. Blocking the ventilation ports generates heat 
inside of scanner, which may results in fire or scanner failure.

Do not place heavy objects on the scanner or use the top surface of the scanner 
for performing other work. Improper installation might cause injuries.

Do not move the scanner with the power and interface cables connected as this 
might damage the cables, causing fire, electric shock or injuries.
Before moving the scanner, be sure to disconnect the power plug from the power 
outlet, and disconnect data cables. Also, make sure that the floor is free of 
obstructions.
xiv



Protect the scanner from static electricity.

Do not use aerosol sprays near the scanner.

Avoid any contact when scanner is in use.

Unplug the power cord from the electrical outlet when the 
scanner is not used for a long period of time.

Do not install the scanner in direct sunlight.

Do not use the scanner immediately after moving it from a cold 
place into a warm room.

Be careful not to cut yourself

Install the scanner away from strong magnetic fields and other sources of 
electronic noise. Also, protect the scanner from static electricity as this might 
cause the scanner to malfunction. 

Do not use aerosol sprays to clean the scanner. Aerosol sprays cause dirt and 
dust to enter the scanner, resulting scanner failure and malfunction.

Avoid touching any scanner mechanism when scanning as this may cause 
injuries.

For your safety, unplug the power cord from the electrical outlet when the 
scanner is not used for a long period of time.

Do not install the scanner in direct sunlight or near heating apparatus. Doing so 
might cause excessive heat to build up inside the scanner, causing fire or 
scanner trouble. Install the scanner in a well-ventilated location.

Do not use the device immediately after moving it from a cold place into a warm 
room. This may cause condensation, which might lead to scanning errors. Let the 
device dry about one or two hours before you use it.

When handling paper or the Carrier Sheet, be careful not to cut yourself by the 
paper or the Carrier Sheet.
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Chapter 1
1
Before You Start Using Your Scanner

This chapter describes the necessary preparations before using ScanSnap.
1.1 Checking the Contents of the Scanner Package ................................................. 2

1.2 Names and Functions of Parts .............................................................................. 3
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1.1 Checking the Contents of the Scanner Package

When you unpack the scanner package, make sure that the package contains all the parts on the list 
included in the package.
2



1.2 Names and Functions of Parts
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1.2 Names and Functions of Parts

This section describes the names of parts and their functions. 

■ Front Side

HINT

You can also use the scanner without the Stacker.

Paper chute
Open the cover to use the scanner.
⇒Opening the cover turns on the scanner.

ADF
(ADF:Automatic Document Feeder)

Paper chute
After opening it, load the documents to be scanned 
on this unit.

Side guide
Adjust the side guides to the width of documents so 

that the scanned images will not get skewed.

Cover open lever
To open the ADF cover, pull this lever towards you.

Operation button
⇒Refer to the next page.

Stacker
Before using the stacker, unfold and extend it as shown above.
ScanSnap  S500 Operator's Guide 3



■ Operation Button

■ Rear Side

SCAN
POWER

[SCAN] button
Press this button to start the scanning.

[POWER] button
Turns on/off the power supply.

Power lamp 
Indicates the scanner status.
Blue (Solid): Ready
Blue (Blinking): Scanning
Orange (Solid): Error
Light off: Power off

Seal (inform you that the installation of the soft-
ware has to be performed first)
After installing the software, remove this seal.

USB connector AC adapter connector
4



Chapter 2
2

Connecting ScanSnap

This chapter describes how to connect ScanSnap to your personal computer. 
Before you connect the ScanSnap scanner, install the supplied programs (Adobe Acrobat, 
ScanSnap Manager, ScanSnap Organizer and CardMinder) on your personal computer.

For details about the space required for installing the scanner, refer to the Appendix, under
"Appendix C Installation Specifications" (page 171). 

2.1 Installing ScanSnap................................................................................................ 6

2.2 Connecting ScanSnap to your PC....................................................................... 22

ATTENTION
• Install ScanSnap Manager before connecting ScanSnap scanner to your per-

sonal computer.
If you connect ScanSnap before installing the ScanSnap Manager, ScanSnap 
will not operate correctly.

• If you have connected ScanSnap beforehand, the "Found New Hardware 
Wizard" (this screen might differ slightly according to the used operating sys-
tem of your computer) screen appears. If this screen is displayed, click the 
[Cancel] button to close the 
Wizard screen and install ScanSnap Manager first.

• ScanSnap S500 cannot be connected to a personal computer with ScanSnap 
fi-4110EOX2, ScanSnap fi-5110EOX Series, or another S500.

• If any driver of the ScanSnap fi-4110EOX2 or ScanSnap fi-5110EOX Series 
has already been installed on your computer, uninstall it before starting the 
installation.

HINT
ScanSnap Manager includes the driver software for ScanSnap fi-4110EOX3 
and ScanSnap fi-5110EOX Series. If you already have any of these products; 
ScanSnap S500 (this product), ScanSnap fi-4110EOX3, ScanSnap fi-
5110EOX, or ScanSnap fi-5110EOX2, you can connect one of them to your 
personal computer and use it.
In addition, available functions vary depending on the model name. For further 
information, refer to Operator's Guide supplied with respective scanners
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2.1 Installing ScanSnap

"Installation" is the operation of copying the program files supplied with ScanSnap to the hard disk 
of your personal computer, and creating the environment for using ScanSnap on the personal com-
puter installed with the ScanSnap program files.

■ Before Installing ScanSnap

Before installing ScanSnap, perform the following preparation.

1. Check your system.
The system requirements for ScanSnap are as follows:

■ Operating system
One of the following OSs is required:
• Windows 98 
• Windows Me 
• Windows 2000 
• Windows XP (Service Pack 1 or later) 

*1: Compatible with Service Pack 2

■ Personal computer
• Intel® Pentium® III 600MHz or higher (recommended: Intel® Pentium® 4 1.8GHz or 

higher)
• CD-ROM drive (required for installation)
• USB port (USB 2.0/1.1)

Windows 98 Windows 98
(2nd Edition) Windows Me Windows 

2000 Windows XP

ScanSnap Manager

ScanSnap Organizer

CardMinder

Adobe Acrobat 7.0 *1

ABBYY FineReader
6
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■ RAM
• 128MB or more (recommended: 256MB or more)

■ Free disk space
• ScanSnap Manager   160 Mbytes
• ScanSnap Organizer   200 Mbytes
• CardMinder   140 Mbytes
• Adobe Acrobat 7.0   450 Mbytes
• ABBYY FineReader   130 Mbytes

■ USB 2.0 support  

* USB 2.0 driver supplied by Microsoft Corporation is required for the usage of the above. 

2. Make sure that ScanSnap is disconnected from your personal computer. 

3. Start up your personal computer.
When using Windows 2000 or Windows XP, log on as a user with "Administrator" privi-
leges (computer administrator privileges when using Microsoft Windows XP Home Edition 
operation system)

4. Close all currently running programs. 

ATTENTION
• ScanSnap may not function if it is connected to the USB ports for the keyboard 

or monitor.
• If you are using a commercially available USB hub, use a type equipped with 

an AC adapter. 
• If you connect the scanner with USB 2.0, it is required that the USB port and 

the hub are compliant with USB 2.0. The scanning speed may slow down 
when you connect the scanner with USB 1.1. If your computer has the USB 
2.0 compatible port, use it. 
Refer to the following list for USB 2.0 support.

• If the CPU and the memory do not meet the required specification, the scan-
ning speed will slow down.

Windows 98 Windows 98
(2nd Edition) Windows Me Windows 

2000 Windows XP

On-board PC 
interface

Expansion 
card interfaces
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■ Installing Adobe Acrobat

Install Adobe Acrobat using the following procedure from the "Adobe Acrobat 7.0 CD-ROM" sup-
plied with the scanner.  

      

ATTENTION "Adobe Acrobat 7.0 Standard" system requirements:
• OS:   Windows 2000 (Service Pack 2 or later).

Windows XP Professional or Home Edition.
• Internet Explorer 5.5 or later
• Screen Resolution: 800 x 600 or higher
* Note: Adobe Acrobat 7.0 is not supported by Windows 98 and Windows Me. If 
you are using one of these OS, install Adobe® Acrobat® Reader™ following the 
instructions in the hint below.
* For further details, please visit Adobe Website at:
   http://www.adobe.com 

HINT
Adobe Acrobat is required for displaying the "ScanSnap S500 Operator’s
Guide", "ScanSnap Organizer User’s Guide", and "CardMinder User’s Guide."
Adobe Acrobat can also be linked to ScanSnap for displaying the scanned 
images on the Acrobat window.

* You do not have to install Adobe Acrobat if it is already installed on your per-
sonal computer. 
⇒ Proceed to "Installing Supplied Programs" (page 15).

<For Windows 98 / Windows Me>
Adobe Acrobat 7.0 is not supported by Windows 98 and Windows Me. To dis-
play a PDF file (e.g. instruction manual and/or a scanned image), install 
Adobe® Acrobat® Reader™ by following the instructions.

1. Insert the Setup CD into the CD-ROM drive.
2. Right-click the Start button and select Explore.
3. Double-click the icon [ar505enu.exe] which is located under [AcroRead] in

the CD.
4. Install the application by following the instructions on the Setup screen.

* Note that it is not possible to edit scanned images with Adobe® Acrobat® 
Reader™.
8
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Operation

Prepare the Adobe Acrobat 7.0 CD.

1. Insert the "Adobe Acrobat 7.0 CD" into the CD-ROM drive. 

⇒ The "Adobe Acrobat 7.0 Standard - Setup" window appears. 

2. Select the language and Click [OK] button.

HINT
Adobe Acrobat 7.0 is not supported by Windows 98 and Windows Me.

HINT
This window is not displayed automatically when the "Auto play" setting of your 
computer is deactivated. In this case, run "AutoPlay.exe" of this CD directly 
using the "Explore" or "My computer."
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3. Select "Install Adobe Acrobat 7.0 Standard."

4. Follow the instructions to install the software.

HINT
Select "How to install" on the "Adobe Acrobat 7.0 Standard" window to learn 
more about the Adobe Acrobat 7.0 installation.

Refer to "Adobe Acrobat Help" about how to use Adobe Acrobat 7.0.
10
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■ Installing ABBYY FineReader

Install ABBYY FineReader by using the following procedure from the "ABBYY FineReader CD" 
supplied with the scanner.
Operation

Prepare the ABBYY FineReader CD.

1. Insert the ABBYY FineReader CD into the CD-ROM drive. 

⇒ The "ABBYY FineReader for ScanSnap" screen appears.  

ATTENTION
• If Windows Service Pack 2 is installed in your computer, you may see the fol-

lowing window when inserting the CD described above. Click the [Yes] button 
to show the "ABBYY FineReader for ScanSnap" screen. 

If the [In the future, do not show this message.] checkbox is marked, you will 
not see this window when inserting a CD that attempts to connect to 
Microsoft Internet Explorer in the future.

• You may see [Information Bar] instead of the one above. If so, first, click the 
[OK] button and then the yellow part with a warning for options. 
Next, select [Allow Blocked Content] from the menu.   
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2. Click [Install>] to proceed with installation.

⇒ The file folder containing the setup.exe file appears.

Finally, click the [Yes] button on the [Security Warning] dialog to proceed.
12



2.1 Installing ScanSnap
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3. Double-click the [Setup.exe] icon.  

4. Select the language for this installation and click [OK]. 

⇒ The InstallShield Wizard for ABBYY FineReader for ScanSnap appears.
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⇒ Follow the instructions to install the software. 

HINT
Select [Start] -> [All Programs] -> [ABBYY FineReader for ScanSnapTM 2.0] -> 
[User’s Guide] to learn more about the ABBYY FineReader installation.
Refer to "ABBYY FineReader for ScanSnap Help" about how to use ABBYY 
FineReader.
14
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■ Installing Supplied Programs 

Install the supplied programs (ScanSnap Manager, ScanSnap Organizer, CardMinder) for Scan-
Snap from the "Setup CD" supplied with the scanner.
Operation

1. Insert the scanner Setup CD into the CD-ROM drive. 

⇒ The "ScanSnap Installer" starts up and then the "ScanSnap Setup" dialog box is dis-
played. 

HINT
If the "ScanSnap Setup" dialog box is not displayed even after inserting the 
Setup CD into the CD-ROM drive, double-click the "Setup.exe" icon in the 
folder of the used CD-ROM drive by using Explore.
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2. Click the [Readme] button in the "ScanSnap Setup" window. 
This item describes the precautions when installing or uninstalling ScanSnap, as well as the 
structure of the files on the Setup CD, and other information. 

⇒When you finished reading the Readme file, close the screen.

3. Click the [Install Products] button in the "ScanSnap Setup" dialog box. 

⇒ The "Welcome to the InstallShield Wizard for ScanSnap" screen is displayed. 
16
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4. Click the [Next] button in "Welcome to the InstallShield Wizard for the ScanSnap"

⇒ The "License Agreement" screen is displayed. 

5. Read the details of the "License Agreement." If you agree with them, click the [Yes] 
button. 

If you do not accept the terms, click the [No] button. This will abort the installation.

⇒When you click the [Yes] button, the "Choose Destination Location" screen is displayed.
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6. In the "Choose Destination Location" screen, choose the installation directory and 
click the [Next] button.

To install ScanSnap in the default folder, click the [Next] button. 
Normally, there is no need to change the folder in the installation directory. Change the 
installation directory if there is not enough free disk space available for the selected drive. 
To change the installation folder, click the [Browse] button. The "Select Directory" dialog 
box is displayed. Select the folder to install ScanSnap.

⇒ The "Setup Type" screen is displayed. 

7. Select an installation option and click [Next] button.
Select [Typical] for ordinary use.

⇒ This displays the "ScanSnap Manager Setting 1" screen.
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8. In the "ScanSnap Manager Setting 1" screen, specify the document loading method, 
and click the "Next" button.

To load the document face down and upside down on the scanner, check the left radio but-
ton.
To load the document face up on the scanner, check the right radio button.

⇒ The next "ScanSnap Manager Setting 2" screen appears.

HINT
Depending on the selected item, the following programs are installed.
• Typical

"ScanSnap Manager", "ScanSnap Organizer" and "CardMinder" are installed 
including their manuals.

• Compact
"ScanSnap Manager" is installed including its manual.

• Custom
You can select the software and the manuals to install.

HINT

• You can change this setting after installation.
Refer to "- Set the documents with its face up" (page 67)" in the section 
"3.4 Changing Scan Settings" for more details.

• This screen will not appear when reinstalling the program. The settings 
before the reinstallation remain.
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9. In the "ScanSnap Manager Setting 2" screen, mark the "Notify scanning result" 
checkbox to notify you of scanning results after scanning, and then click the [Next] 
button.

If the checkbox is marked, the notification screen showing will show the details about the 
status of blank page removal and image rotation.

⇒ This displays the "Start Copying Files" screen.

10. In the "Start Copying Files" screen, check the files that will be installed and click the 
[Next] button.

⇒ This starts the installation of the programs supplied with ScanSnap. After the installation 
is finished, the "InstallShield Wizard Complete" screen will be displayed.

HINT

• You can change this setting after installation.
Refer to "3.4 Changing Scan Settings" (page. 53) for more details.

• This screen will not appear when reinstalling the program. The settings 
before the reinstallation remain.
20
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11. In the "InstallShield Wizard Complete" screen, click the [Finish] button.

⇒ Select "Yes, I want to restart my computer now" to restart your personal computer.
⇒ Sselect "No, I will restart my computer later." to finish the installation. The "ScanSnap 

Setup" dialog box appears; click the [Exit] button to close the "ScanSnap Setup" dialog 
box.
(To complete the installation, you have to restart your personal computer.)

HINT

• To display the "ScanSnap S500 Operator’s Guide", "ScanSnap Organizer 
User's Guide", and "CardMinder User’s Guide, " Adobe Acrobat or Adobe® 
Acrobat® ReaderTM is required. If this software is not installed on your per-
sonal computer, install Acrobat 7.0 from the "Adobe Acrobat 7.0 CD" supplied 
with the scanner.

• For uninstallting these programs, refer to"Appendix B Uninstalling ScanSnap" 
on page.169.
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2.2 Connecting ScanSnap to your PC

Follow the procedure below to connect ScanSnap to your personal computer.
1. Connect ScanSnap to a power outlet using the AC cable. 
2. Connect ScanSnap to your personal computer using the USB cable. 

The following describes each of the above two procedures.

■ Connecting the AC Adapter

Connect the power cable as shown below. 
Operation

1. Connect the AC cable to the AC adapter. 

2. Connect the AC adapter to the AC adapter connector on ScanSnap and to a power outlet.

ATTENTION
• Be sure to connect the AC cable first before connecting the USB cable. 
• Be sure to install ScanSnap Manager to your personal computer before con-

necting ScanSnap to your personal computer. (For details about the installa-
tion, refer to "Installing ScanSnap" (page 6)).

ATTENTION Do not use cables other than the ones supplied with this product. 
Use only specified AC cable and AC adapter.

AC cable AC adapter

Outlet

Inlet
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■ Connecting the USB Cable

Connect the USB cable as shown below. 

Operation

1. Remove the seal on the rear side of ScanSnap scanner.

2. Insert the USB cable into the USB connector of ScanSnap and plug the other end of 
the cable into the USB port on your personal computer.

Insert firmly the USB-cable as far as it can go into the connector.

ATTENTION
• Use only the USB cable supplied with the Scanner. The operation with a com-

mercially available USB cable is not guaranteed. 
• When connecting to a USB hub, be sure to connect the scanner to the hub 

nearest your personal computer (first stage). If you connect it to a USB hub 
from the second stage onwards, ScanSnap may not function correctly. 

• If you connect the scanner with USB 2.0, it is required that the USB port and 
the Hub are compliant with USB 2.0. The scanning speed may slow down 
when you connect the scanner with USB 1.1. If your computer has the USB 
2.0 compatible port, use it. 

DC   16V

Seal

USB cable

USB cable
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3. Open the paper chute of ScanSnap.

⇒ ScanSnap is automatically turned on and detected by your personal computer.

Operation

4. ScanSnap is added as new hardware.
How to add hardware varies with the OS running on your computer.

■ For Windows 98
The "Insert Disk" dialog box is displayed. 
Insert the Windows 98 CD into the CD drive, and then click the [OK] button. 

■ For Windows Me
New hardware is automatically added, and processing continues. 

■ For Windows 2000
The "Digital Signature Not Found" dialog box is displayed. Click the [Yes] button. 

ATTENTION If the scanner is not automatically turned on, push the [POWER] button on the 
scanner.

Paper chute
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■ For Windows XP
1) When the "Found New Hardware Wizard" dialog box is displayed, select "No, not

this time" and then click the [Next ->] button.

2)  Click the [Next] button in the following window.

ATTENTION The above windows may not appear unless Windows XP Service Pack 2 is 
installed.

ATTENTION Although the message "If your hardware came with an installation CD or floppy 
disk, insert it now." is displayed, you do not need to insert the CD into the CD-
ROM drive.
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3) The "Hardware Installation" dialog box is displayed. Click the [Continue Anyway] 
button.

4) When the "Found New Hardware Wizard" dialog box informing you that the Wiz-
ard will end is displayed, click the [Finish] button. 

⇒ ScanSnap is added to your personal computer as new hardware.

ATTENTION It may take some time for the "ScanSnap Manager" icon on the taskbar to 

become ready  status. 
Push the [POWER] button on the scanner when the icon appears in not-ready  

 status. 
When you turn on/off the scanner, wait for five seconds.

HINT
When you turn on/off the scanner, press the [POWER] button for longer than 
one second.

* To prevent unintended operation, the [POWER] button does not work unless 
it is pressed for longer than one second.

SS

SS
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HINT
The power supply of this scanner is controlled by performing the following 
actions:
• Open/close the paper chute on the scanner.
• Turn on/off the personal computer to which the scanner is connected.
• Press the [POWER] button on the scanner (when the paper chute is opened).
Opening /closing the paper chute controls the scanner’s power. For example, 
the scanner will not be turned on even when you have switched on your per-
sonal computer if the paper chute is closed.

Generally, you can simply turn on/off the scanner only by opening/closing the 
paper chute when the scanner is connected to your personal computer.
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Chapter 3
3

Basic Scanner Operations

This chapter describes the basic operations of ScanSnap.
3.1 Flow of Operations ............................................................................................... 30

3.2 Scanning Different Document Types .................................................................. 36

3.3 Loading Documents ............................................................................................. 39

3.4 Changing Scan Settings....................................................................................... 53

3.5 Saving Scan Settings ........................................................................................... 78

3.6 Changing Carrier Sheet Settings......................................................................... 86
ScanSnap  S500 Operator's Guide 29



3.1 Flow of Operations 

This section describes the flow of operations starting with the scanning of documents on ScanSnap 
to the saving of scanned images in PDF format. 

■ Preparation

Operation

1. Make sure that the AC cable is connected to the scanner.

2. Make sure that the scanner is correctly connected to your personal computer.

3. Turn on your personal computer.
⇒ The "ScanSnap Manager" icon appears when Windows starts.

4. Open the paper chute.

⇒ The scanner is turned on and the "ScanSnap Manager" icon will change from  to .

HINT
You can connect the scanner to your computer after turning it on. When the 
scanner is already connected to your personal computer, you do not need to 
reconnect it.

HINT
If the scanner is not automatically turned on even when the paper chute is 
opened, push the [POWER] button on the scanner.

Paper chute

[POWER] button

SS SS
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■ Scanning documents

Operation

1. Make sure that the "ScanSnap Manager" icon is displayed on the taskbar.

2. Load the document onto the scanner.
Refer to "3.2 Scanning Different Document Types" (page 36) and "3.3 Loading Documents" 
(page 39) for more information. 

3. Press   ([SCAN] button).
⇒ This starts the scanning.

HINT
If the "ScanSnap Manager" icon is not displayed on the taskbar, select [All Pro-
grams] -> [ScanSnap Manager] -> [ScanSnap Manager] from the [Start] menu 
to start up "ScanSnap Manager."
Generally, "ScanSnap Manager" is registered under "Startup" programs, so its 
icon is displayed on the task tray when Windows starts. If it is not registered 
under "Startup" programs, select [All Programs] -> [ScanSnap Manager] -> 
[Startup Register] from [Start] menu to register it.

HINT
As the default setting, documents are scanned with the "Duplex" mode when 
you press the [SCAN] button. With "ScanSnap Manager", you can set the scan-
ner to scan documents using "Simplex" mode when pressing the [SCAN] but-
ton.

ATTENTION
• Do not connect or disconnect other USB devices during the scanning opera-

tion.
• Do not close the paper chute or press the [POWER] button on the scanner 

during the scanning operation.
• Do not switch the user to log in during the scanning operation.
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⇒ The lamp on the scanner lights blue during the scanning operation.
The following window appears to indicate the scanning status.

⇒ The supplied application (ScanSnap Organizer) is started up and the scanned image is 
displayed.

For details about the settings for the scanning, file names and the destination folder to 
save the data, refer to "3.4 Changing Scan Settings" (page 53).
About the scanning of Business cards, refer to "4.3 Scanning Business Cards" (page 119).   

 

HINT
As the default setting, documents are scanned according with the following set-
ting: "Image quality: Normal" and "Color mode: Auto Color Detection."
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HINT
• Before scanning documents containing printed or handwritten text, select the 

"Setting for text only document" checkbox under [Option] on the [Scanning] tab 
in the "Scan and Save Settings" dialog box. For details, refer to "3.4 Changing 
Scan Settings" (on page 53). 

• The application that is automatically started up after the scanning depends on 
the setting of the [Application] tab in the "Scan and Save Settings" dialog box. 
For details, refer to "3.4 Changing Scan Settings" (on page 53). 

• Scanned documents can also be saved in an image format (JPEG). In this 
case, change the document scan settings before scanning the document. For 
details about changing the document scan settings, refer to "3.4 Changing 
Scan Settings" (on page 53). The following document scan settings can be 
changed:

•Application linked to ScanSnap
•Folder for saving scanned images
•File name of scanned images
•File format for scanned image (*.pdf/*.jpg)
•Scan mode (draft, high quality, reduce noise of back side image, auto-

matically remove blank pages, adjust skewness, change loading doc-
ument direction, continue scanning)

•Size of file for scanned image
•The compression ratio of scanned images

The scanning scale may vary slightly.
• With Adobe Acrobat 7.0, scanned images (saved as a PDF file) can be pro-

cessed with the following functions:
- Convert a scanned page to searchable text

From the menu, select [Document] - [Recognize Text Using OCR] - 
[Start]
In case of using colored images, verify that the image has been 
scanned in "Better" or "Best" Image quality mode before performing 
this operation. (refer to page 62)

- Reduce PDF file size
From the menu, select [File] - [Reduce File Size]

For details on how to use the above functions, refer to [Acrobat 7.0 Help]. 
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■ Turning the Scanner ON/OFF

ScanSnap is automatically turned on/off by performing the following actions:

• Turn on/off the personal computer.
• Open/close the paper chute of the scanner.
In general, you do not need to turn on/off the scanner when it is connected to your personal com-
puter.

Turn off your personal computer or close the paper chute.

The lamp on the scanner goes off and the scanner is turned off.

Turn on your personal computer or open the paper chute.

The lamp on the scanner lights up and the scanner is turned on.

To turn off the scanner when the paper chute is opened, press the [POWER] button on the scanner.    

HINT
When you turn on/off the scanner, press the [POWER] button for longer than 
one second.

* To prevent unintended operation, the [POWER] button does not work unless it is 
pressed for longer than one second.

ATTENTION
• Depending on your personal computer, the ScanSnap scanner is initialized 

several times while starting up the personal computer.
• It may take two to three minutes for turning off the lamp on the scanner 

depending on your personal computer.
* This is related to the specification of the computer, not to malfunction of the 
scanner.
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■ End of Operation

Closing "ScanSnap Manager"

Operation

Right-click "ScanSnap Manager" icon  on the taskbar, and select "Exit" from the menu.

Disconnecting the scanner

Operation

1. Close the paper chute to turn off the scanner.

⇒ The "ScanSnap Manager" icon in the taskbar changes from the "Active" icon to the 

"Inactive"  icon.

2. Disconnect the USB cable from your personal computer.

3. Disconnect the AC cable from the power outlet.

HINT
"ScanSnap Manager" should be started for operating ScanSnap. To start 
"ScanSnap Manager", select [All Programs] -> [ScanSnap Manager] -> [Scan-
Snap Manager]. 
(*Generally, there is no need to quit "ScanSnap Manager.")

HINT
The power of the scanner is controlled by turning on/off of the personal com-
puter or opening/closing of the paper chute. In general, you do not have to turn 
on/off the scanner when it is connected to your personal computer.

SS

SS
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3.2 Scanning Different Document Types

The table below summarizes the types of documents that can be scanned with this scanner.      

When scanning documents directly

Media Paper commonly used in offices, 
Post card, Business card

Weight 52 g/m2 to 127 g/m2 (14 lb to 34 lb)

Size

Letter
Legal
A4
A5
A6
B5 (JIS)
B6 (JIS)
Post card
Business card
Custom

(8.5 x 11 in (216 x 279.4 mm))
(8.5 x 14 in (216 x 355.6 mm))
(210 × 297 mm)
(148 × 210 mm)
(105 × 148 mm)
(182 × 257 mm)
(128 × 182 mm)
(100 × 148 mm)
(90 × 55mm, 55 × 90mm)
Width: 50.8 to 216 mm (2 to 8.5 in)
Length: 50.8 to 360 mm (2 to 14.17 in)

When using Carrier Sheet

Media Paper commonly used in offices, Post card, Business card, 
Photograph, Clipping

Weight Up to 127 g/m2 (Up to 34 lb) *Fold in two when scanning

Up to 63.5 g/m2 (Up to 17 lb)

Size

A3
A4
A5
A6
B4 (JIS)
B5 (JIS)
B6 (JIS)
Post card
Business card 
Letter
11 x 17
Custom

(297 × 420 mm)
(210 × 297 mm)
(148 × 210 mm)
(105 × 148 mm)
(257 × 364 mm)
(182 × 257 mm)
(128 × 182 mm)
(100 × 148 mm)
(90 × 55 mm, 55 × 90 mm)
(8.5 x 11 in (216 x 279.4 mm))
(11 x 17 in (279.4 x 431.8 mm))
Width: 50.8 to 216 mm (2 to 8.5 in)
Length: 50.8 to 297 mm (2 to 11.69 in)
*For B4, A3 and 11 x 17, fold in two when 
scanning
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ATTENTION
• Documents written or filled with a pencil may be smeared during a scan. It is 

recommended to use Carrier Sheet. If such documents are scanned without 
using Carrier Sheet, the rollers get dirty and the paper may not be fed properly. 
In the case where you scan such documents without using Carrier Sheet, 
clean the rollers as often as possible. For details refer to "6.2 Cleaning the 
Scanner Exterior" (page 147).

• Carbonless paper contains chemical substances that may harm the Pad ASSY 
or rollers (e.g. Pick roller) when documents are fed. Pay attention to the follow-
ing:
- Clean the Pad ASSY or rollers as frequently as possible.
- The service life of the scanner may be shortened compared with the case of 
scanning woodfree paper.

HINT
Do not use the following documents:

• Documents with paper clips or staples (they can be used after the paper clips 
or staples are removed)

• Documents on which the ink is still wet (they can be used after the paper is 
completely dry)

• Documents larger than Legal (width: 8.5 in, length: 14 in)
• Documents folded in half larger than 216 x 297 mm (W x L) (8.5 x 11.7 in)
• Materials other than paper such as fabric, metal foil, or transparencies
• Carbon paper
•  Thermal paper

If you load the following documents directly on the scanner, the documents 
may be damaged or may not be scanned successfully. 
It is recommended to insert the documents inside the Carrier Sheet to scan.

• Documents smaller than 2 (width) x 2 (length) inches 
• Documents thinner than 52 g/m2 (14 lb) and thicker than 127 g/m2 (34 lb)
• Documents of non-uniform thickness (e.g. envelopes and paper which has 

another paper pasted on.)
• Wrinkled or curled documents
• Folded or torn documents
• Tracing paper
• Coated paper
• Photographs (printing paper)
• Perforated or punched documents
• Documents that are not square or rectangular
• Documents of non-uniform width
• Carbonless paper
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Also, pay attention to the following when you use the Carrier Sheet.

ATTENTION
• Use only the Carrier Sheet for ScanSnap.
• Avoid writing, coloring, staining or cutting the black and white pattern part of 

the Carrier Sheet. Otherwise, the scanner cannot recognize the Carrier Sheet 
correctly.

• Load the Carrier Sheet one by one on the scanner.
• Do not place the Carrier Sheet upside-down on the scanner. Otherwise, a 

paper jam may happen, or the Carrier Sheet may be damaged.
• Do not leave a document on the Carrier Sheet for a long period of time. The 

ink may be transferred onto the Carrier Sheet.
• Do not leave the Carrier Sheet in high-temperature places such as a place fac-

ing direct sunlight or near a heating apparatus for a long period of time. Also, 
do not use the Carrier Sheet under a high-temperature environment. Other-
wise, it may warp.

• Do not bend, twist, or pull the Carrier Sheet forcibly.
• Do not use a damaged Carrier Sheet. Otherwise, the scanner may be 

damaged or malfunction.
• To avoid warping the Carrier Sheet, keep it in a horizontal place where it is not 

weighed down, if possible.
• Do not rub the edge of the Carrier Sheet with your finger. Otherwise, your fin-

ger may get cut.
• If you scan multiple small-size materials such as the picture and post card 

using Carrier Sheet at one time, a paper jam may occur. It is recommended to 
put such materials in Carrier Sheet one-by-one for scanning.
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3.3 Loading Documents

This section describes how to load documents onto the scanner.

■ How to load documents

1. Align the edges of the document. 

Align the edges of the document as follows:
1) Straighten the edges of the document.

Straighten both edges of the document stack for scanning it correctly.
2) Check the number of sheets in the document stack.

The maximum number of sheets that can be loaded on the scanner is as follows:
For A4-size paper or smaller, a document stack of 5 mm or less (50 sheets at 64 
g/m2 or at 17 lb).

To prevent paper jams, fan the document as follows:

1) Take out the stack of documents of thickness 5 mm or less.
2) Hold both ends of the document with both hands, and bend the documents into an 

arch. 

HINT
Scanning accuracy increases when the 
document is loaded onto the scanner so 
that the leading edges of the papers form a 
step-like pattern as shown in the figure.

For the option of "Set the documents with its face up" in the setting of the "Scan-
ning" tab in "ScanSnap Manager", load the document with its face up and the bot-
tom edge down.

Back
Back

Scanning direction

Step-like

5mm
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3) Firmly holding the document with both hands and bend back the document as fol-
lows so that the bent section rises up in the middle of the document. 

4) Repeat steps 1) to 3) a few times. 
5) Turn the document staple 90 degrees, hold the other two sides of the document, and 

fan it again. 

2. Load the document onto the paper chute.
Load the document so that the top side of the two-sided document (in the case of two or 
more document sheets, the first page) faces towards the paper chute.
Reduce the quantity of the documents, when the thickness of stack exceeds the reference 
marks on the side guides.

 

ATTENTION
If the checkbox for [Set the docu-
ments with its face up] of [Scanning] - 
[Options] in the "Scan and Save Set-
tings" window of ScanSnap Manager 
is selected, set the front of the docu-
ment with the top edge face-up.

ABCDEFG
ABCDEFG

1234567890
1234567890

Reference 
Paper chute

Side guide

mark

ABCDEFG
ABCDEFG1234567890

1234567890
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3. Adjust the side guides to the document width.

Move the side guides so that there is no space between the document edges and the side 
guides. If there is a space between the document edges and the guides, the scanned images 
may be skewed.

 

        

HINT
Before loading long-sized documents, first pull out the extension of the paper 
chute.

Extension

Document
Side guide

Paper chute
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HINT
If you use the stacker, scanned document sheets will not be separated when 
they have passed through the scanner. For details on how to attach the stacker 
to the scanner, refer to "Names and Functions of Parts" on page 3.

Use the stacker as described below.
1. Pull out the stacker towards you while holding it by its handle.

2. Extend the stacker.

Stacker
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■ Loading Documents with the Carrier Sheet

The Carrier Sheet is a sheet for loading document specifically designed for ScanSnap S500/fi-
5110EOX2 Series. It allows you to scan documents that cannot be scanned as it is. A document 
larger than A4 up to A3, B4 or 11 x 17 (single side) can be scanned by folding it in two, inserting it 
into the Carrier Sheet and scanning in duplex mode. 

You can scan documents that can be easily scratched such as photographs or irregular-shaped doc-
uments that are difficult to load on the scanner such as clippings of information (e.g. magazine and 
newspaper). 

The following explains how to insert documents into the Carrier Sheet.

There are two [Modes] which are tailored to the type of document to be scanned in the Carrier 
Sheet settings.   

Create facing pages in one image
(page 44)

Scan a document larger than A4 size such as A3/B4/
11" x 17" which is folded in two in duplex mode, 
and then output an image arranged in two-page 
spread and joined together.

Create front and back images 
separately (page 49)

This mode is for scanning photographs which you do 
not want to scratch, or documents of irregular size 
such as clippings of information that are difficult to 
load and scan directly on the scanner.

Output the scanned image in specified sizes.

ATTENTION
• When you use the Carrier Sheet, select [Automatic Detection] in the set-

ting of the [Paper size] tab in "ScanSnap Manager."
If scanning is done using "Create facing pages in one image", select 
"Duplex Scan" in the setting of [Scanning] tab in "ScanSnap Manager." If 
you select "Simplex Scan", it will produce the same result as using "Cre-
ate front and back images separately" to scan in simplex.
Refer to "3.6 Changing Carrier Sheet Settings" (page 86) for details on 
changing the "Carrier Sheet" Settings.

• If you are using the Carrier Sheet for scanning, it is not possible to scan 
multiple sheets continuously. Load the sheets one by one and scan.
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For "Create facing pages in one image"

This mode is for scanning documents larger than A4 size, such as A3/B4/11" x 17."

Fold a document in two, scan in duplex and an image joined together is generated. (If a document 
smaller than A4 printed on both sides is scanned, it is possible to output a two-page spread image.)

Operation

1. Right-click "ScanSnap Manager" icon  on the taskbar, and select "Settings."

2. On the [Paper Size] tab, click the "Carrier Sheet Settings" button.

SS
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3. On the "Carrier Sheet Settings" window, change "Mode" to "Create facing pages in 
one image" and click [OK].

4. Select "Duplex Scan" in "Scanning side’" on the [Scanning] tab.
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5. Select "Automatic Detection" in "Paper size" on the [Paper size] tab, and click the 
[OK] button.
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Operation

6. Spread the page to be scanned facing outwards and fold it in half from the center.
Fold it neatly so that the folded portion does not appear puffed. If the folded portion is not 
folded neatly, it may cause skewing.

7. Open the Carrier Sheet and place the document inside.

8. Load the Carrier Sheet onto the scanner.

Align the top of the document to the top of 
the Carrier Sheet, and the folded 
portion to the top-right corner closely.

• Place the top of the sheet with the black 
& white printed pattern downwards and 
load it in the direction of the arrow.

• When you load the Carrier Sheet, adjust 
the side guides so that it will not skew.

• If you are using the Carrier Sheet for 
scanning, it is not possible to scan 
multiple sheets continuously. Load the 
sheets one by one and scan.
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9. Press the [SCAN]  button.
⇒ The front and back image data are set in a facing-page state and generated side by side.

ATTENTION
• There may be a gap in the joined portion, or a line may appear in the out-

put image.
If you are scanning a thick document, the image has a tendency to skew 
in such a way that the upper portions tilt towards each other at the joined 
area.
In these situations, the skew is caused by the way in which the document 
is folded, or the loading method.
Do the following. The situation may be improved.
- Is the document neatly folded? If not, fold it neatly.
- Is the edge of the document aligned closely to the edge of the Carrier
  Sheet? If not, align them.
- Load the Carrier Sheet by turning the front side back. 

• In the "Carrier Sheet Settings" window, when "Automatic Detection" in 
"Output image size" is selected, the generated image size may be smaller 
than the document.
(The smallest size to include all the data on the document is selected from 
among A3, B4 and 11" x 17")
Example: If the document printed as A4 size in the center of an A3 docu-
ment is scanned,
=> it is generated in B4 size.
To output an image that is the same size as the document size, set the 
document size in [Output image size].

• If a paper jam occurs frequently, feed about 50 sheets of PPC paper or 
recycled paper, and then scan the document by using Carrier Sheet.
* You can use either unused or used PPC/recycled paper.
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For "Create front and back images separately"

This mode is for scanning documents such as photographs which you do not want to scratch, or 
clippings of information that are difficult to be fed.

Operation

1. Right-click "ScanSnap Manager" icon  on the taskbar, and select "Settings."

2. On the [Paper Size] tab, click the "Carrier Sheet Settings" button.

SS
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3. On the "Carrier Sheet Settings" window, change "Mode" to "Create front and back 
images separately" and click [OK].

4. Select "Automatic detection" in "Paper size" on the [Paper size] tab.
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Operation

5. Open the Carrier Sheet and place the document inside.

6. Load the Carrier Sheet onto the scanner.  

Align the top of the document so that it 
touches the top of the Carrier Sheet.
Place the document on its width in the 
center, in order not to protrude out of the 
Carrier Sheet.

• Place the top of the sheet with the black 
& white printed pattern downwards and 
load it in the direction of the arrow.

• When you load the Carrier Sheet, adjust 
the side guides so that the document will 
not skew.

• If you are using the Carrier Sheet for 
scanning, it is not possible to scan 
multiple sheets continuously. Load the 
sheets one by one and scan.

ATTENTION
If the checkbox for "Set the documents with its face up" of [Scanning] - 
[Options] in the "Scan and Save Settings" window of ScanSnap Manager is 
selected, set the front of the document with the top edge face-up.

Back side Back side
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7. Press the [SCAN]  button.
⇒ Scanning starts, and the image data is generated in the specified size.

  

ATTENTION
• The output image is generated with the scanned document image placed in 

the center of the specified size.
In the "Carrier Sheet Settings" window, when "Automatic Detection" in "Out-
put image size" is selected, an ideal size among the standard sizes is 
selected automatically (refer to "3.6 Changing Carrier Sheet Settings" (page 
86)).

• In the "Carrier Sheet Settings" window, when "Automatic Detection" in "Output 
image size" is selected, the generated image size may be smaller than the 
document.
Example: If A5 size image is printed in the center of an A4 document
=>it is generated in A5.
To output an image that is the same size as the document size, set the docu-
ment size in "Output image size."

HINT
If the following symptoms are observed, place a piece of white paper behind 
the document.
• The scanned document cannot be generated in a suitable size (in [Automatic 

Detection])
• A shadow appears on the edges of the document
• Black lines appear around the document that is cut into an unusual shape

white paper
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3.4 Changing Scan Settings

All the operations of ScanSnap are controlled by the "ScanSnap Manager."

Generally, ScanSnap Manager is registered on the taskbar and displayed as the icon .

Right-click this icon to show the following menu. With this menu, you can start scanning, config-
ure settings for scanning, or check consumables.

This section describes the settings on the "Scan and Save Settings" window.

The following settings can be changed:

• Application that starts automatically and interacts with ScanSnap   [Application]
• Destination to save scanned images   [Save]
• Scan mode (high speed scan, high quality scan, scan in color mode, scan in B&W mode, 

reduce noise of back side image, automatically remove blank pages, automatically correct 
document skewness/direction, method of loading documents, continue scanning) 

  [Scanning] 
• File format for the scanned image   [File option]

(file option, specification of pages per PDF file, and password for PDF files)
• Document scan size   [Paper size]
• Size of the file when saving scanned images   [Compression]

SS

Start Duplex/Simplex scanning.

The "Scan and Save Settings" window appears.

The "Profile Management" window appears.

The screen to notify whether the removal of blank 
paper/image rotation has been done appears after 
scanning.

The "Check consumable supplies" window 
appears.

Display Help topics, About ScanSnap Manager 
Exit ScanSnap Manager
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The following describes how to change the settings.

Operation

1. Right-click the "ScanSnap Manager" icon on the taskbar and select "Settings" from 
the displayed menu.

⇒ The "Scan and Save Settings" dialog box is displayed.    

2. Change the scan settings on the "Scan and Save Settings" window.

3. Click the [OK] button.
⇒ The Scan and Save settings are changed.

HINT
You can launch the "Scan and Save Settings" dialog box by simultaneously 
pressing [Ctrl] + [Shift] + [Space] or double-clicking the icon on the taskbar.
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The following describes each setting on the "Scan and Save settings" window.

[Setting when left-clicked]

Select a scan setting profile.

• Standard
• CardMinder
• Searchable PDF (OCRs during scan)

 

■ The [Add Profile] button
You can add new profile settings selectable to the "Setting when left-clicked" menu for 
selection.

■ The [Edit Profile] button
You can change profile names or delete them from the "Setting when left-clicked" menu 
excepting "Standard" profile. 

HINT
You can register scan setting profiles.
Registered setting profiles are added to the "Setting when left-clicked" drop-
down menu.
For details on how to register a profile, refer to "3.5 Saving Scan Settings" 
(page 78).
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[Application] tab

■ Application:
Specify the application to be executed and linked to ScanSnap. The specified program 
is started up after the document is scanned on ScanSnap. Click the drop-down arrow  

 to select the application. 
You can select one of the following applications. 

• Scan to File (image data will be simply saved as files)

• Adobe®Acrobat®

• Adobe®Acrobat® Reader™ or Adobe® Reader® 
• CardMinder
• ScanSnap Organizer
• ABBYY Scan2Excell
• ABBYY Scan2Power Point
• ABBYY Scan2Word
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■ [Add or Remove] button
Applications can be added or removed at "Application."
When you click the [Add or Remove] button, the following screen is displayed.

(Up to 10 applications can be registered.) 

<To add an application> 
1) Click the [Add] button. 
2) The following screen is displayed. 

• Click the [Browse] button. Select either the shortcut file (.lnk) of the application to 
register or the executable file (.exe). 
⇒ The folder of the selected application is displayed in the "Path" field. 

• Enter a name for the new application. 
⇒ The application name is displayed in the "Application" drop-down list. 

3) When you have finished the setting, click the [OK] button. 

HINT
• The above applications automatically become available when they are 

installed. If they are uninstalled, they are no longer displayed among the selec-
tion items. 

• If you select "Scan to File (only saves image data as files)", the scanned 
image is saved to file after the scanning is completed. The scanning result is 
not displayed on screen. This setting is ideal when the scanning result needs 
not be confirmed each time a document is scanned. 

• If you select "CardMinder " at "Application" on the [Application] tab, the [Save], 
[File option], [Paper size] and [Compression] tabs are not displayed. 

• When the CardMinder is activated, the application in "Application" on the 
[Application] tab automatically enters the mode specified by "CardMinder." 
When you exit CardMinder, the originally specified mode will be restored. 
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4) The following screen is displayed and the new application is added. Click the 
[Close] button to close the screen.

<To remove an application> 
1) Select the application you want to remove in the "Add or remove application" 

screen, and the click the [Remove] button. 
2) The confirmation screen will be displayed. Click the [Yes] button in this screen to 

remove the application. 
3) Confirm that the application has been removed, and then click the [Close] button.

<To change settings> 
1) Select the application to change in the "Add or remove application" screen, and 

click the [Change] button. 
2) The "Setting of additional application" screen is displayed. Change the desired 

items. 
3) When you have finished the setting, click the [OK] button. 
4) The "Add or remove application" screen is displayed, and the settings are changed. 

Click the [Close] button to close the screen. 

HINT
When you add an application, select an application that is able to process files 
of the following formats.
  JPEG (*.jpg), PDF (*.pdf)
Scanned images cannot be displayed properly unless these file formats are 
supported.
Depending on applications, password-protected PDF files may not be opened.
This can be confirmed by the following method:
<Example: To confirm if the selected application is able to process files of 
JPEG format>

1. Create a shortcut for the application you wish to add. 
2. Drag-and-drop any file in JPEG format (*.jpg) onto the shortcut. 

⇒ If the application starts up and the file is opened, the application sup-
ports JPEG format files.

However, certain applications that satisfy the above requirements may not work 
properly. In that case, start up the application first and then open the files cre-
ated by ScanSnap.
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[Save] tab

■ Folder path to save an image: 
Specify the folder to save the scanned image.
When you click the [Browse] button, the "Browse for Folder" screen is displayed.
Select the folder to save the scanned image and then click the [OK] button.

  

ATTENTION
The function "Make New Folder" is not provided for Windows 98.
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■ [Filename format] button
Set the name of the file to save the scanned image.
When you click the [File name format] button, the following screen is displayed. 

 
The following three settings can be specified.
1  "Date and time (depending on the setting of your operating system)"

Files are named according to the settings of the operating system of your personal 
computer.
When there is any character inappropriate for file names, like (/;+,*>”<>|), such 
character will be replaced by "-" (hyphen).

2 "Date and time (yyyyMMddHHmmss)"
Set the date and time for the file name when saving a scanned image to a file. 
Example: If the file is saved in PDF at 19:00:50 on December 27, 2003, the file name will 
be 20031227190050.pdf

3  "Custom File Name"
A file is named combining the text string entered at "File Name" and the number 
with the digits specified at "Counter."
(An example of a file name is displayed on the bottom of the screen when you 
select the format.)

HINT
When "ScanSnap Organizer" is selected at [Application], the [Image saving 
folder:] and the [Browse] button are grayed out, and you cannot specify the 
folder to save images from this window.
In this case, scanned images are saved in the "My ScanSnap Folder" specified 
by ScanSnap Organizer (page 122).

HINT
About "Counter"
• When there is no other file with the same name as the one specified at "File 

Name" in the save destination folder (specified on the [Save] tab), the counter 
becomes 1 (001 in the case of three digits). From then on, the counter is incre-
mented by one upon saving a new file.

• When there is a file having the same name in the save destination folder, the 
counter becomes the smallest unused number. 
Example: When files Scan01.pdf, Scan03.pdf, Scan04.pdf exist in the folder, 
and the scanned images are saved to files having the same "file name" (i.e. 
"scan") prefix, Scan02.pdf, Scan05.pdf, Scan06.pdf, Scan07.pdf and so forth.

•  When the specified number of digits is exceeded (for example, when saving 
the 100th file with two digits are specified.), the number of digits is incre-
mented by one. 
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Clicking the [OK] button enables the settings.
(An example of the file name that you set is displayed under the [Filename format] but-
ton.) 

■ Rename file after scanning
If the checkbox is selected, the [Save scanned image as] window appears after scanning.

You can change the folder to save the scanned files, or rename files in this screen.

HINT
• The filename is set in the [Filename format] screen in advance. If there is no 

need to rename, click the [Save] button.
• If multiple files are generated with one scan, counters are appended after the 

file name. (  File name + counter.extension)
Example 1: In [PDF File Option] (page 57), select [Generate PDF file after xx 
pages]. If a document with pages exceeding the 
specified pages is scanned, they become:

Scan001.pdf, Scan002.pdf, Scan003.pdf...
Example 2: If saving in JPEG, they become:

Scan001.jpg, Scan002.jpg, Scan003.jpg...
*The examples are the results of using "Scan" as the file name for all files.
*The digit number follows the settings of the [Filename format] screen.
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[Scanning] tab

■ Image quality:
Specify whether to scan documents quickly or at higher quality.
Select one of the following modes: 

• Normal (Fastest) 
Select this mode when you wish to scan documents quickly. 

• Better (Faster)
Select this mode when you wish to scan documents at higher quality. 

• Best (Slow)
Select this mode when you wish to scan documents at even higher quality.

• Excellent (Slower)
Select this mode when you wish to scan documents at the highest quality 

HINT
Normal is equivalent to 150 dpi for color and 300 dpi for B&W, Fine is equiva-
lent to 200 dpi for color and 400 dpi for B&W, Best is equivalent to 300 dpi for 
color and 600 dpi for B&W, and Excellent is equivalent to 600 dpi for color and 
1200 dpi for B&W.
Generally, the higher the required image quality is specified, the longer it takes 
to scan documents and the larger the file size becomes.
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■ Color mode:
Specify whether to scan documents in color or black-and-white.
Select one of the following modes: 

• Auto Color Detection (Automatically recognize each document color)
ScanSnap automatically recognizes whether the document to scan is colored or 
black-and-white and switches the scan mode accordingly. 

• Color
Scans the document in the color mode.
This setting is ideal for scanning colored documents.

• B&W
Scans the document in the B&W mode.
This setting is ideal for scanning black-and-white documents containing mostly 
text. File sizes can also be kept smaller at the B&W setting compared to the color 
mode. 

• Color high compression
Saves colored documents as a highly compressed file.
  

HINT
• Normally, set this setting to "Auto Color Detection." 

If this setting is specified, there is no need to change the color mode each time 
you scan a document.
Note that colors may be regarded as black and white in the following kinds of 
documents.
- Faintly toned paper
- Partially colored documents
To scan such documents in color mode, select "Color" as "Color mode."

• In "Color high compression" mode, characters and backgrounds on the docu-
ment are compressed separately, and thus, the file size of the document that 
mostly consists of text characters becomes smaller while keeping the quality of 
the characters as they are.
However, this mode is not appropriate for scanning photographs or figures 
because these graphical materials are recognized as background and com-
pressed as such, causing degradation in images.
If this setting is specified, the contrast of the image may become higher.

• Depending on the kinds of documents, file size may increase if you use color 
high compression mode than if you do not. The file size of the following kinds of 
documents may become larger.
- Documents that contain many pictures and/or graphics but fewer characters 
written in black
- Documents of complex layout (e.g. multiple columns)
- Documents with patterned background
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■ Scanning side:
You can select the type of scanning (single-sided or double-sided) when pressing the 

[SCAN] button  on the scanner.
Select [Duplex Scan] or [Simplex Scan] from the menu.

■ Continue scanning after current scan is finished
If the checkbox is marked, the following message appears after scanning.

To continue scanning, load a document onto the scanner, and then click the 
[Continue Scanning] button.
To finish scanning, click the [Finish Scanning] button.
After the [Finish Scanning] button is clicked, the scanned images are gener-
ated in one file.
*It is possible to continue scanning up to 1000 pages.
*The maximum PDF file size is 1G byte. Although it is possible to generate 
a file larger than 1G byte, when viewing it with Adobe Acrobat, a message 
may appear to tell that the file is corrupted and being fixed.

■ [Option] button
With this item you can configure other scanning related settings. 
Clicking the [Option] button displays the following screen.
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- Brightness (Black and White scanning only)
Sets the density for scanning black-and-white images. 
Moving the slider control to the left will lighten the scanned image, while moving 
the slider control to the right results in a darker scanned image. 
* This setting becomes available when "B&W" is selected at "Color mode" or 

when "Auto Color Detection" is selected in the "Color mode" drop-down list 
and black-and-white documents are automatically recognized. 

- Setting for text only document.
Select the checkbox as follows according to the type of your document. 

• Select this checkbox when scanning documents contain printed or handwritten 
text. 

• Clear this checkbox when scanning documents contain photographs. 
* This setting becomes available when "Color" or "Auto Color Detection" is 

selected in the "Color mode" drop-down list and color documents are automati-
cally recognized.

- Allow automatic blank page removal.
This setting automatically detects blank pages in the document stack and removes 
them from the output. 
For example, when a stack of documents containing both two-sided and one-sided 
documents is scanned in Duplex mode, this feature removes only the back side (i.e. 
blank page) of one-sided documents from the output images.
* No scanned images are output if all of the sheets in the document stack are rec-

ognized as blank pages. 

- Correct skewed character strings automatically.

ATTENTION
The following types of documents may be accidentally recognized as blank 
pages.
• Almost blank documents contain only a few characters
• Document of only one color (including black) and without any patterns, lines, 

or characters.
Before discarding the scanned documents, check for pages accidentally 
removed from the output image. If any, you need to re-scan the document.
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This setting automatically detects skewed documents and corrects them for the out-
put data. Up to +/-5 degrees of skews can be corrected.

ATTENTION
This function judges a document skew based on the characters on the docu-
ment. So the detection may not work properly for the following kinds of docu-
ments:
• Documents on which the pitches of lines or characters are extremely narrow, 

or characters are overlapped
• Documents which have many outline characters or using font styles like that
• Documents with many photographs or figures and only a few characters
• Documents with a background pattern behind the characters
• Documents with characters printed in various direction (e.g. plans)
• Documents with long diagonal lines
• Documents with handwritten characters
*When you scan such documents, clear the checkbox.
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- Allow automatic image rotation.
This setting automatically judges the orientation of a text on the document, and 
changes the orientation of the image.    

- Set the documents with its face up    

ATTENTION
This function judges the orientation based on characters on the 
document, so it does not work properly for the following document:
• Documents which have many extremely large/small characters
• Documents on which pitches of lines or characters are extremely narrow, or 

characters are overlapped
• Documents which have many characters that contact underlines or ruled lines
• Documents which have many photographs or figures and a few characters
• Documents which have a background pattern behind characters
• Documents which have characters printed in various directions (e.g. plans, 

etc.)
• Documents which have only capital letters
• Documents with handwritten characters
• Unclear or smeared characters
*When you scan such documents, clear the checkbox.

Select the checkbox if you want 
to scan the document in your 
hand as shown in the 
picture.

Scanning starts from the last 
page. After all the documents 
are scanned, the data is sorted 
in order from the first page 
onwards and output to a file.

ATTENTION
The scanning speed is slower due to the process of sorting the data after 
scanning.
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[File option] tab

■ Selecting the file option
Specify the type of file for the scanned image. 
Click the drop-down arrow   to select the file format. You can select one of the fol-
lowing. 

• PDF (*.pdf)
• JPEG (*.jpg)  

ATTENTION
"JPEG" setting is not available when "Auto Color Detection," "B&W," or "Color 
high compression" is selected in the [Color mode] drop-down list on the [Scan-
ning] tab, or when "ScanSnap Organizer" is selected in the [Application] drop-
down list.
The file format is automatically changed to "PDF" when you select "Auto Color 
Detection" or "B&W."
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■ Searchable PDF (OCRs during scan)
You can use this function only when PDF is selected in the [File format:] drop-down 
list. By marking the checkbox, you can create a searchable PDF file.

■ Select text recognition language:
You can select a language for conversion to recognize text.

■ Select page for text recognition:
• All pages

All pages are recognized as text when a PDF file is created.
• First page

Only the first page is recognized as text when a PDF file is created.

ATTENTION
• Available only for Windows 2000 and Windows XP.
• Marking this checkbox may require an extended period of processing depend-

ing on your personal computer environment.
• ScanSnap may fail to correctly recognize the following kinds of documents 

(characters) as text. However, by changing Color mode and/or improving 
Image quality for scanning, such a document may be successfully text-recog-
nized. 
- Handwritten documents
- Documents including smaller characters and scanned in low quality
- Skewed documents
- Documents written in languages other than the specified language for text 

recognition
- Documents including texts written in Italic characters
- Superscript/subscript letters and complex mathematical formulas
- Characters are written against an unevenly-colored or patterned background

• Characters to which effects (Shadow, Outline, and the like) are applied 
• Shaded characters

- Documents of complex layout as well as documents including unreadable 
characters (due to print-through and smudges)

(It may take an extended period of time to scan documents described above.)
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■ [Option] button
This function is used for configuring detailed settings of PDF files. This button is 
enabled when "PDF(*.pdf)" is specified at [File format:]. Click [Option] button to 
display the following dialog box.

• "Multipage PDF (whole batch in one PDF)" 
Creates a merged PDF file of all the scanned images.

• "Generate one PDF file per xx pages" 
Create a new PDF file at each set page. For example, when "2" pages are set in 
this option, scanning 6 pages of documents creates 3 files.

■ Set a password for PDF file
You can set a password for a PDF file created after scanning. It becomes impossible to 
open a password-protected file if you do not enter the password for that file.
The "Enter password" screen appears whenever the scanning finishes. Enter a password two 
times (one is for confirmation), and then click the [OK] button.

*If you click the [Cancel] button, the file is saved as a normal PDF file 
without a password.

Use a fixed password
You can set a fixed password in advance for all the PDF files so that the "Enter 
password" screen will not appear when you scan.

ATTENTION
If you select Adobe Acrobat and Adobe Reader (or Acrobat Reader) at "Appli-
cation", only the first file is displayed on the screen when two or more files are 
created by one scanning. (If you select other applications, follow the specifica-
tions of the application to find out how the files are displayed.)
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If you select the checkbox, the [Password] and the [Confirm] fieldes become 
enabled. Enter the same password in these two fieldes.

ATTENTION
• You can set a password using the following:

Maximum number of characters: 16
Characters: A-Z, a-z, 0-9
Symbols: ! " # $ % & ' ( ) * + , - . / : ; < = > ? @ [ \ ] ^ _ ` { | } ~

• If the operating system you are using is Window 98 or Window Me, this func-
tion is enabled only if Adobe Acrobat is installed on your computer.

* Note: If you forget your password, the PDF file cannot be opened.
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[Paper size] tab

■ Paper size:
Specify the size of the document to be loaded on the scanner. 
Click the drop-down arrow   to select the size. The following paper sizes (W x L) 
can be selected. 

• Automatic detection
• Letter (8.5 x 11 in (216 x 279.4 mm))
• Legal (8.5 x 14 in (216 x 355.6 mm))
• A4 (210 x 297 mm)
• A5 (148 x 210 mm)
• A6 (105 x 148 mm)
• B5 (JIS) (182 x 257 mm)
• B6 (JIS) (128 x 182 mm)
• Post card (100 x 148 mm)
• Business card (90 x 55 mm, 55 x 90 mm)
• Custom (up to 10 settings can be registered)

ATTENTION
To use the Carrier Sheet, "Automatic detection" must be selected.
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■ [Custom] button
You can use this function to register up to 10 customized document sizes at the [Paper 
size] menu. Clicking this button displays the following setting window:

‘
<When adding a customized document size>
1) Click the [Add] button.

2) The following screen appears.

- Enter the document size within the range given below.
Width: 50.8 - 216 mm (2 - 8.5 in)
Length: 50.8 - 360 mm (2 - 14.17 in)

- Enter a name in the [Name] field.
⇒ The name is displayed in the [Paper size] field.

3) To complete the setting, click the [OK] button.

4) The customized document size will be registered.
Click the [Close] button to exit the "Add or Remove Custom sizes" window.

<When deleting a customized document size>
1) In the "Add or Remove Custom sizes" window, select the document size to be 

deleted and click the [Remove] button.

2) The confirmation message appears. Click the [Yes] button to delete the customized 
size.

3) Make sure that the selected size is deleted from the list. Click the [Close] button to 
exit the "Add or Remove Custom sizes" window.
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<When changing the settings>
1) In the "Add or Remove Custom sizes" window, select the document size to be 

changed and click the [Change] button.

2) Change the settings in the "Additional custom size settings" womdow.

3) To complete the setting, click the [OK] button.

4) The screen returns to the "Add or Remove Custom sizes" window and the changes 
are saved. Click the [Close] button to exit the "Add or Remove Custom sizes" win-
dow.

   

■ "Scan mixed paper size"
By marking the checkbox, you can scan the documents of different widths or sizes at a 
time.

■ [Carrier Sheet Settings] button
You can set or change settings to scan with the carrier sheet.

ATTENTION
• Do not load documents with different sizes simultaneously onto the scanner.
• When you select Business card (90 mm x 55, 55 mm x 90 mm) and scan:

From the scanned length, the horizontal or vertical position is automatically 
recognized and scanned.
For length (loading direction), it is the actual scanned length of the card.
For width, it is fixed at 90 mm (horizontal position), or 55 mm (vertical 
position).

ATTENTION
For information about how to set the Carrier Sheet Settings, refer to "3.6 
Changing Carrier Sheet Settings" (page 86).
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[Compression] tab

■ Compression rate:
Control the compression rate to specify the size of the file for the scanned image. 
The compression rate is changed by moving the slider.
The larger the compression rate number is specified, the higher the compression rate is 
set and the smaller the file size becomes.      

ATTENTION
When the compression rate is increased, the quality of scanned images deteri-
orates. 

HINT
If you select "Color high compression" mode on the [Scanning] tab, the file size 
becomes far more smaller by increasing the compression rate. 
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ATTENTION
• In "Color high compression" mode, characters and backgrounds on the docu-

ment are compressed separately, and thus, the file size of the document that 
mostly consists of text characters becomes smaller while keeping the quality 
of the characters as they are. However, this mode is not appropriate for scan-
ning photographs or figures because these graphical materials are recognized 
as background and compressed as such, causing degradation in images. If 
this setting is specified, the contrast of the image may become higher.

• Depending on the kinds of documents, file size may increase if you use color 
high compression mode than if you do not. The file size of the following kinds 
of documents may become larger.
- Documents that contain many pictures and/or graphics but fewer characters 
written in black
- Documents of complex layout (e.g. multiple columns)
- Documents with patterned background
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HINT
About the size of image data

The following table shows a rough guideline for calculating the size of 
images when a single color document is scanned in the Simplex mode. 

File type: PDF
Paper size: A4 (Brochure)

Color mode: Color

Color mode: Color high compression

Color mode: B&W

                                                                                   (unit: Kbytes)

* "Color high compression" is effective in "Best quality" or "Excellent quality" 
mode.
* For more efficient use, adjust Compression rate and/or select "Color high 
compression" mode as follows:

-Setting Compression rate (1 to 5) reduces the file size when scanning 
documents such as photographs or figures.

-Selecting "Color high compression" reduces the file size even more when 
scanning documents including many characters (at Best/Excellent).

 
Scan mode

Compression rate
1 2 3 4 5

Normal quality 743 312 256 178 100
Better quality 1169 548 395 300 186
Best quality 2503 1018 790 575 352
Excellent quality 10210 4084 2884 1981 1793

 
Scan mode

Compression rate
1 2 3 4 5

Normal quality 524 329 270 180 159
Better quality 787 459 393 137 97
Best quality 1107 572 238 176 147
Excellent quality 1560 724 574 475 380

Scan mode Compression rate
Normal quality 135
Better quality 221
Best quality 485
Excellent quality 1681
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3.5 Saving Scan Settings

You can save and assign names to the current settings in ScanSnap Manager.
With just a click of the ScanSnap icon, you can retrieve and use the saved settings easily.

You can create different types of frequently used scanning conditions in advance, and when you 
open the Settings screen during scanning, it is easy to scan without changing the settings one by 
one.
The following explains the operation procedure.

■ Creating Scan Settings

Operation

1. Right-click "ScanSnap Manager" icon , and select "Setting."

2. On the "Scan and Save Settings" window, change the scan settings.
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3. When you have finished changing the settings, click the [Add Profile] button.

⇒ The "Left-click menu" window appears.

4. Enter a profile, and click the [OK] button.

⇒ The new profile becomes available for selection from the "Setting when left-clicked" 
drop-down menu.

5. Click the [OK] button, and the "Scan and Save Settings" window closes.
⇒ A new profile is created.

HINT
• You can create a maximum of 10 scan profiles, including the "Standard" 

profile. (You cannot delete the "Standard" profile.)
• You can change the sequence of the profiles except for the "Standard" pro-

file.
1. Right-click the "ScanSnap Manager" icon and select "Profile Manage-

ment" to open the "Profile Management" window.
2. Select a profile name from the list to change the display order.
3. Click the [Up] or [Down] button to move the profile name up or down. 

  
4. Click the [Close] button.
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■ Scanning with a Saved Scan Setting

Operation

1. Left-click the ScanSnap icon .

⇒  A list of saved profiles appears.
(The icon of the application on the left of the profile name.)

2. Select the scan setting to use.
⇒ A check mark appears on the selected profile.

3. Load the document on the scanner.

4. Press the [SCAN] button .
⇒ Scanning is carried out with the selected scan profile.

  

HINT
"Application" shown on the [Application] tab will be CardMinder when Card-
Minder is activated and it will be changed to ScanSnap Organizer when 
ScanSnap Organizer is activated. (When both of them are active, CardMin-
der has priority.) In such case, "ScanSnap Organizer is interacting" appears 
with a check on the Left-click menu. When CardMinder and ScanSnap 
Organizer are deactivated or other profiles are selected, "ScanSnap Orga-
nizer (or another application name) is interacting" will disappear.
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■ Changing the configurations of a Scan Setting

Operation

1. Right-click the ScanSnap icon , and select "Setting."

2. From the "Setting when left-clicked" drop-down list on the "Scan and Save Settings" 
window, select a profile you want to change.

3. Change the configurations on the selected profile. 
For detailed information on how to configure the scan settings on a profile, refer to ."3.4 
Changing Scan Settings" (page 53)
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4. After changing the configurations on the selected profile, click the [OK] button.

⇒  A file overwrite confirmation message appears.

5. To overwrite the configurations select the [Yes] button. If you do not want to change 
the configurations, then click the [No] button.

Clicking the [Cancel] button will return you to the "Scan and Save Settings" window.

(When you change the configuration of the "Standard" profile, the confirmation message 
will not appear.)

HINT
If you select another profile from the "Setting when left-clicked" drop-down 
list before clicking the [OK] button, the following message will appear.

Clicking the [Yes] button will change the configurations on the current profile, 
and switch to another profile.
Clicking the [No] button will cancel the changes for the current profile and 
switch to another profile.
Clicking the [Cancel] button will return you to the "Scan and Save Settings" 
window.
82



3.5 Saving Scan Settings

B
asic S

canner O
perations

3

■ Renaming Scan Settings

Operation

1. Right-click the ScanSnap icon , and select "Setting."

⇒The "Scan and Save Settings" screen appears.

2. Click the [Edit Profile] button.

⇒The "Profile Management" screen appears.

3. Select the profile name from the list, and click the [Rename] button.

4. On the "Rename" window, type a new name and click the [OK] button.
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■ Deleting Scan Settings

Operation

1. Right-click the ScanSnap icon , and select "Setting."

⇒ The "Scan and Save Settings" screen appears.

2. Click the [Edit Profile] button.

 

⇒ The "Profile Management" screen appears.

HINT
You can also invoke the "Profile Management" screen by right-clicking Scan-

Snap icon . The "Profile Management" screen appears when selected on 
the Right-click menu. Follow the same procedures described in the previous 
page to change the profile name. Select a profile from the list and then click 
the [Rename] button.

SS
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3. Select a profile name from the list, and then click the [Delete] button.  

4. The "Delete Profile" window appears with the confirmation message. Click the [Yes] 
button to delete the profile.

HINT
You can also invoke the "Profile Management" screen by right-clicking Scan-

Snap icon . The "Profile Management" screen appears when selected on 
the Right-click menu. Follow the same procedures described in the previous 
page to delete the profile name. Select a name from the list and then click the 
[Delete] button.
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3.6 Changing Carrier Sheet Settings

Carrier Sheet settings are changed on the "Carrier Sheet Settings" screen.
The "Carrier Sheet Settings" screen appears when the [Carrier Sheet Settings] button on the [Paper 
size] tab is clicked.

Right-click the "ScanSnap Manager icon"  on the taskbar, and select "Settings" from the menu.

⇒ The "Scan and Save Settings" screen appears.

Click the [Carrier Sheet Setting] button on the [Paper size] tab to display "Carrier Sheet Settings" 
screen.
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The following explains the settings that can be changed on the "Carrier Sheet Settings."

Mode
Specifies the scanning method for using the Carrier Sheet.
The following are two modes.

•Create facing pages in one image
Scan a document folded in two half, in duplex mode and output an image of 
facing pages joining the front and back images together. This mode is for 
scanning a document larger than A4 size, such as A3/B4/11" x 17."

•Create front and back images separately
Outputs a cropped image which fits the size of the scanned document.
This mode is for inserting and scanning documents such as photographs 
which you do not want to scratch, or documents of irregular size such as 
clippings of information that are difficult to load and scan directly on the 
scanner, in the Carrier Sheet.
If both sides are scanned, the front and back images are generated 
separately.

ATTENTION
• When scanning in [Create facing pages in one image] mode, select [Duplex 

Scan] on the [Scanning] settings of [ScanSnap Manager].
• The method of loading documents differs with the mode. Refer to "Loading 

Documents with the Carrier Sheet" (page 37) for more details.

Change the 
Carrier Sheet 
settings here.

A simple 
explanation for 
the [Mode].

The image of 
the [Mode].

Enable the setting, and close the screen.

Cancel the setting, and close the screen.
Show help.
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Output Image Size
Specifies an image size when generating a scanned image.
You can select it from the following document sizes.     　

Mode: Create facing pages in one 
image

Mode: Create front and back images 
separately

Automatic Detection Automatic Detection

A3 (297 x 420 mm) -

- Carrier Sheet size (216 x 297mm)

- A4 (210 x 297mm)

- A5 (148 x 210mm)

- A6 (105 x 148mm)

- Post Card (100 x 148mm)

B4 (JIS) (257 x 364 mm) -

- B5 (JIS) (182 x 257mm)

- B6 (JIS) (128 x 182mm)

- Letter (8.5 x 11in, 216 x 279.4 mm）

11  x 17 (11 x 17 in, 279.4  x 431.8 mm) -

- Business Card Portrait (55 x 90mm)

- Business Card Landscape (90 x 55mm)

- Custom (Can create up to 10)

HINT
• If you specify [Automatic Detection] on [Output image size], the size of the scanned 

document is automatically determined among the standard sizes (other than Custom 
and Carrier Sheet Size) described in the above table. There is no need to re-specify an 
[Output image size] to fit the loaded document for that reason.

• If you specify [Carrier Sheet size] on [Output image size], the scanned image is gener-
ated in the Carrier Sheet size. After scanning, you can trim the image to your preferred 
size with applications such as Adobe Acrobat 7.0.
To trim the image using Adobe Acrobat 7.0, from the menu bar, select [Tools] -> 
[Advanced Editing] -> [Crop tool], and double-click the selected area for the necessary 
image portion.

ATTENTION
• If you specify [Automatic Detection] on [Output image size] to scan a 

document which size is not among the possible scan sizes on the above table, the 
scanned image is bigger than the document size as well as nearest to the fixed size
If you want to scan a document in its size, create a document size at the [Custom] 
button, and select that size on [Output image size].

• If you specify [Automatic Detection] on [Output image size], the 
generated size may be bigger than that of the scanned document. In this case, carry 
out the following operation.
- Insert the document into the Carrier Sheet straight.
- When you load the Carrier Sheet onto the scanner, use the side guides to secure 
the Carrier Sheet.

If the situation does not improve with the above methods, specify the size of 
the document on [Output image size].
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[Add custom size] button
You can create up to 10 custom sizes.
When you click the button, the following settings screen appears.

To add custom size documents
1)Click the [Add] button.
2)The following screen appears.

•Enter the document sizes.
You can set within these range:
Width: 50.8 - 216 mm (2 - 8.5 in)
Length: 50.8 - 297 mm (3 - 11.69 in)

•Enter a name you want to display in [Name:].
⇒The entered name is displayed on [Add or Remove Custom sizes].

3)When you complete the settings, click the [OK] button.
4)A new custom document size is created.

Click the [Close] button, and the "Add or Remove custom sizes" screen closes.

To delete custom size documents
1)On the "Add or Remove custom sizes" screen, select the document size you 

want to delete, and click the [Delete] button.
2)When the confirmation screen appears, click the [Yes] button.
3)On the [Add or Remove custom sizes] screen, check that the document size is 

deleted, and click the [Close] button.
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To change settings
1)On the [Add or Remove custom sizes] screen, select the setting of the docu-

ment size you want to change, and click the [Change] button.
2)The [Additional custom sizes settings] screen appears. Change the items you 

want to change.
3)When you have completed the settings, click the [OK] button.
4)The "Add or Remove custom sizes" screen appears, and the settings have 

changed. Click the [Close] button, and the screen closes.
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Chapter 4
4

Various settings according to your needs

This chapter describes the basic operations of ScanSnap.
4.1 Using ScanSnap Manager.................................................................................... 92

4.2 Using Adobe Acrobat ......................................................................................... 115

4.3 Scanning Business Cards.................................................................................. 119

4.4 Using ScanSnap Organizer................................................................................ 124

4.5 Using ABBYY FineReader.................................................................................. 130
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4.1 Using ScanSnap Manager

When you use ScanSnap with the default settings, you do not have to change any configuration. 

All you need to do is simply pressing the [SCAN] button  to scan the documents, save images 
with the optimized settings and display the scanned images on the screen without any complicated 
operation.
However, you can also manually configure the settings as you need.
This section describes how to scan documents for specific purposes or how to edit scanned images, 
etc.

HINT
The default settings of ScanSnap are as follows:
• Application: ScanSnap Organizer
• Image saving folder: [My ScanSnap] folder
• Filename format: Date and time (Use operating system setting: yyyyMMddH-

Hmmss (Year, Month, Day, hour, minute, second)
• Rename file after scanning: Disabled
• Image quality: Normal (Fastest)
• Color mode: Auto Color Detection (automatically determines whether the 

document is "color" or "black and white")
• Scanning side: Duplex Scan
• Continue scanning after current scan is finished: Disabled
• Scanning Option:

Brightness: Normal
Setting for text only document (in Color mode only): Disabled
Allow automatic blank page removal: Enabled
Correct skewed character strings automatically: disabled
Allow automatic image rotation: Enabled
Set the documents with its face up: Disabled

• File format: PDF (*.pdf)
• File format Option

PDF File Option: Multipage PDF (whole batch in one PDF)
Generate one PDF file per xx page: Disabled
Set a password for PDF file: Disabled
Use a fixed password: Disabled

• Paper size: Automatic detection
• Scan mixed paper size: Disabled
• Carrier Sheet settings:

Mode: Create facing pages in one image
Output image size: Automatic detection

• Compression
Compression rate: 3

These settings can be changed with ScanSnap Manager.
For details, refer to the "3.4 Changing Scan Settings" (page 53).
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■ Scanning only one side of a document

As the default setting, pressing the [SCAN] button  on ScanSnap scanner starts scanning docu-
ments in "Duplex" mode. If you wish to use "Simplex" scanning by pressing the [SCAN] button, 
change the settings by following the procedure below.

Operation

1. Right-click the "ScanSnap Manager" icon  on the task bar and select "Settings" 
from the menu.

2. Click the [Scanning] tab and select "Simplex scan" from the "Scanning side" drop-
down menu.

3. Click the [OK] button to save changes and close the window.

4. Load the document onto the scanner.

5. Press the [SCAN] button .
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⇒ The document is scanned in the "Simplex" mode.

■ Scanning color document in black and white

As the default, ScanSnap  automatically recognizes whether a document is black & white or 
colored. Accordingly colored documents are scanned in the color mode, while black & white docu-
ments are scanned monochrome.
If you wish to scan colored document in black & white, change the settings by following the proce-
dure below.

Operation

1. Right-click the "ScanSnap Manager" icon  on the task bar and select "Settings" 
from the menu.

2. Click [Scanning] tab and select "B&W" at "Color mode."
If you scan color documents in color, select "Color."

HINT
To return the setting to the "Duplex" mode, select [Duplex scan] in  Step 2. The 
selected setting is applied to further scans unless it is changed again.
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3. Click the [OK] button to close the dialog box.

4. Load the document onto the scanner.

5. Press the [SCAN] button .
⇒ Scanned images will be output in black and white.

■ Scanning color documents in high compression mode

With ScanSnap, you can scan and save color documents in "Color high compression" mode so that 
the file size of data can be reduced.
If you scan the enormous quantity of documents in the "Color high compression" mode, for exam-
ple, you can store colored documents as a space-saving PDF file.
In addition, you can increase the compression rate further by draging the slider to the right on the 
[Compression] tab. 
To scan color documents in high compression mode, perform the following steps to change set-
tings.

Operation

1. Right-click the "ScanSnap Manager" icon  on the task bar and select "Settings" 
from the menu.
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2. Click the [Scanning] tab and select "Color high compression" at "Color mode."

3. Click the [OK] button to close the dialog box.

4. Load the document onto the scanner.

5. Press the [SCAN] button .
⇒ Scanned documents will be output as highly compressed color images.

ATTENTION
In "Color high compression" mode, characters and backgrounds on the docu-
ment are compressed separately, and thus, the file size of the document that 
mostly consists of text characters becomes smaller while keeping the quality of 
the characters as they are. However, this mode is not appropriate for scanning 
photographs or figures because these graphical materials are recognized as 
background and compressed as such, causing degradation in images. If this 
setting is specified, the contrast of the image may become higher.
96



4.1 Using ScanSnap Manager

V
arious settings according to your needs

4

■ Skipping blank pages

ScanSnap is able to recognize blank pages and remove them from the output data. When scanning 
documents in "Duplex" mode, both sides of the documents are scanned regardless if their back-
sides are printed or not. Though the empty back sides are scanned, they are recognized as "blank" 
and automatically removed, so they will not appear on the output data.
To change the setting, follow the procedure below.

Operation

1. Right-click the "ScanSnap Manager" icon  on the task bar and select "Settings"
from the menu.

2. Select the [Scanning] tab and click the [Option] button.
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3. Select the "Allow automatic blank page removal" checkbox.

 

4. Click the [OK] button to close the window.
⇒ The setting is enabled from next scanning. 

■ Correcting skewed documents

ScanSnap is able to automatically correct document skews. To change the setting, follow the 
procedure below.

Operation

1. Right-click the "ScanSnap Manager" icon  on the task bar and select "Settings" 
from the menu.

ATTENTION
The following types of documents may be accidentally recognized as blank 
pages:
• Almost blank documents containing only a few characters
• Documents of only one color (including black) and without any patterns, lines, 

or characters
*When you scan such documents, clear the checkbox.
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2. Select the [Scanning] tab and click the [Option] button.

3. Select the "Correct skewed character strings automatically" checkbox.

4. Click the [OK] button to close the window.
⇒ The setting is enabled from next scanning.

ATTENTION
Up to +/-5 degrees of skews can be corrected.
This function determines a document skew based on the characters printed on 
the document, so it may not work properly for the following document:
• Documents on which the pitches of lines or characters are extremely narrow, 

or characters are overlapped
• Documents with many outline characters or using font styles like this
• Documents with many photographs or figures and only a few characters
• Documents with a background pattern behind characters
• Documents on which characters are printed in various direction (e.g. plans)
• Documents with long diagonal lines
• Documents with handwritten characters
*When you scan such documents, clear the checkbox.
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■ Correcting the orientation of scanned images

When there are different types of page orientation in a document, ScanSnap is able to automati-
cally correct the orientation of the scanned images for the document. For example, it is often seen 
that a document has portrait pages for text contents and landscape pages for tables. For the case of 
double-sided documents in calendar style, their rear sides are printed upside down.
To change the setting, follow the procedure below.

Operation

1. Right-click the "ScanSnap Manager" icon  on the task bar and select "Settings" 
from the menu.

2. Select the [Scanning] tab and click the [Option] button.
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3. Select the "Allow automatic image rotation" checkbox.

4. Click the [OK] button to close the window.
⇒ The setting is enabled from next scanning.

    

■ Scanning documents of different widths or sizes at a time

By marking the "Scan mixed paper size" checkbox, you can scan documents of different widths or 
sizes in one batch.
To scan documents of various sizes, do the following.

Operation

ATTENTION
This function determines a document orientation based on the characters 
printed on the document. So it may not work properly for the following kinds of 
documents:
• Documents with many extremely large/small characters
• Documents on which the pitches of lines or characters are extremely narrow, 

or characters are overlapped
• Documents with many characters that contact underlines or ruled lines
• Documents with many photographs or figures and only a few characters
• Documents with a background pattern behind characters
• Documents on which characters are printed in various directions (e.g. plans)
• Documents with only capital letters
• Documents with handwritten characters
*When you scan such documents, clear the checkbox.
ScanSnap  S500 Operator's Guide 101



1. Right-click the "ScanSnap Manager" icon  on the task bar and select "Settings" 
from the menu.

2. Select the [Paper size] tab. 

3. Mark the "Scan mixed paper size" checkbox. 
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4. Click the [OK] button to close all the windows opened. 

5. Align the edge of all documents. 

6. Load documents onto the paper chute.   

ATTENTION
This function is available only when "Automatic detection" is selected from the 
"Paper size" drop-down menu.
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7. Press the [SCAN] button  .

⇒  The size of all images output conforms to the respective documents.

ATTENTION
• Place all documents in the center under the pick roller.

(Documents that are not under the pick roller cannot be fed.)

• Adjust the side guide to the widest document.
• Carefully load the smaller documents, which cannot contact the side guide, so 

that they can be fed straight. If the documents are skewed during a scan, the 
quality of scanned images may be degraded (chipped images/slant lines pro-
duced) or scanned images may be output in different size from the original.
If you have difficulties feeding documents straight, it is recommended to scan 
documents in several batches; scan documents of about the same size in one 
batch.
Note that smaller documents that cannot be guided by the side guide may 
cause a jam.
104



4.1 Using ScanSnap Manager

V
arious settings according to your needs

4

■ Saving scanned images in multiple files

ScanSnap can save scanned images in multiple files based on the specified number of pages.
For example, you can scan a batch of documents and create files for every single page.
To change the setting, follow the procedure below.

Operation

1. Right-click the "ScanSnap Manager" icon  on the task bar and select "Settings" 
from the menu.

2. Select the [File option] tab and click the [Option] button.

ATTENTION
Make sure that "PDF(*.pdf)" is selected at "File format."
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3. In the "PDF File Option" window, select "Generate one PDF file per x page(s)" and 
enter a number.

One PDF file is created every time when the specified number of pages have been scanned.

4. Click the [OK] button to close the window.
⇒ The setting is enabled from next scanning.

HINT
In "Duplex" mode, two pages (front/back) are created per document sheet. It is 
recommended that you clear "Allow automatic blank page removal"; select the 
[Scanning] tab -> [Option] button to open the window. If this function is enabled, 
there may be a discrepancy between the page numbers of the original docu-
ment and the resulting document in which blank pages may be deleted.
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■ Merging scanned images divided by scanning errors into one PDF 

file

When you are scanning documents and saving them in PDF format, the following window 
appears if the scanning is interrupted by a paper jam or error.

You can resume or abort the scanning by the following procedure.

Operation

To resume scanning:

1. Check the last page scanned on the "Message" window.

2. Load the unscanned pages back onto ADF.

3. Click the [Continue Scanning] button to restart the scanning.

To quit scanning:

1. Click the [Quit] button.

⇒ The following window appears.

2. Click [Yes] to delete the data that were scanned up to the interruption. Otherwise, 
click [No] to save the data that were scanned up to the interruption. (*Click [Cancel] 
not to quit but to return to the previous window.
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ATTENTION
The [Continue Scanning] button may not be displayed on the window and an 
error message like the example below may appear. In this case, it is not possi-
ble to resume scanning. You will use Adobe Acrobat if you want to merge two 
divided image files. (This operation is only available for files of PDF format.)

The following shows the procedures for this operation:
1. Confirm the last page scanned on the "Message" window.
2. Click the [Quit] button, then the following window appears. 

3. Click the [No] button to save the image (PDF file) scanned before the
interruption (this file is called "File A").

4. Scan the remaining documents (this part is called "File B").
5. Open "File A" with Adobe Acrobat.
6. From the menu bar, select [Document] - [Insert Pages].
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ATTENTION

7. Select "File B" in the "Select File to Insert" screen and click the [Select] 
button.   

⇒The "Insert Pages" window will appear. 

8. Select "After" from the Location menu and "Last" from Page radio buttons,
then click [OK].
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■ Setting Passwords for Scanned Documents

You can set passwords for files scanned with ScanSnap and saved in PDF format.
No one can read the content of a password-protected PDF file unless he/she enters the password to 
open the file.
Thus, if you save confidential or important documents with passwords after scanning, you can pre-
vent such information from being leaked.

Operation

1. Right-click the ScanSnap icon , and select "Settings."

2. Click the [File Option] tab, and then click the [Option] button.

ATTENTION
Check that "PDF (*.pdf)" is selected in "File Format."
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3. Select the checkbox for "Set a password for PDF file" on "PDF File Option."

To enter a password for every scan
Clear the checkbox for "Use a fixed password."

⇒ You can enter a different password for every scan.

To use a fixed password decided in advance
1) Select the checkbox for "Use a fixed password."

⇒ The same password is used for all PDF files.
There is no need to enter a password for every scan.

2) Enter the same password for "Password" and "Confirm."

4. Click the [OK] button to close all the screens.

5. Load the document onto the scanner.

6. Press the [SCAN] button .
⇒ Scanning starts.

HINT

You can use the following characters to set your password.
Maxium number of characters: 16
Characters: A-Z, a-z, 0-9
Symbols: ! " # $ % & ' ( ) * + , - . / : ; < = > ? @ [ \ ] ^ _ ` { | } ~
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⇒ In step 3, if the checkbox for "Use a fixed password" is cleared, the following screen 
appears.

In the "Password" and "Confirm" fields, enter the same password, and click the [OK] 
button.

⇒ The scanned document is saved as a password-protected PDF file.
 

HINT
• You can use the following characters to set your password.

Maximum number of characters: 16
Characters: A-Z, a-z, 0-9
Symbols: ! " # $ % & ' ( ) * + , - . / : ; < = > ? @ [ \ ] ^ _ ` { | } ~

• If you click the [Cancel] button, the PDF file is saved without a password.

ATTENTION
• Note: If you forget your password, the PDF file cannot be opened.
• If the operating system you are using is Window 98 or Window Me, this func-

tion is enabled only if Adobe Acrobat is installed on your computer.
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■ Performing text recognition when scanning documents

You can perform text recognition when scanning documents. Doing so can make a searchable 
PDF file (OCRs during scan).

Operation

1. Right-click the ScanSnap icon , and select "Settings."

2. Click the [File Option] tab, and then select "PDF" from the "File format" drop-down list.

 

3. Mark the checkbox in order to "Searchable PDF (OCRs during scan)."
When performing text recognition for all pages, select "All pages" or for the first page, select 
"First page" on the tab.  
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4. Click the [OK] button to close all the screens.

5. Load the document onto the scanner.

6. Press the [SCAN] button .
⇒ Scanning starts.

The document scanned is saved as a searchable PDF file, which has been recognized as 
text.

ATTENTION
• Marking this checkbox may require an extended period of processing 

depending on your personal computer environment.
• ScanSnap may fail to correctly recognize the following kinds of documents 

(characters) as text. However, by changing Color mode and/or improving 
Image quality for scanning, such a document may be successfully text-recog-
nized. 
- Handwritten documents
- Documents scanned in low quality, including smaller characters.
- Skewed documents
- Documents written in languages other than the specified language for text 

recognition
- Documents including texts written in Italic characters
- Superscript/subscript letters and complex mathematical formulas
- Characters are written against an unevenly-colored or patterned back-

ground
• Characters to which effects (Shadow, Outline, and the like) are applied 
• Shaded characters

- Documents of complex layout as well as documents including unreadable 
characters (due to print-through and smudges)

(It may take an extended period of time to scan documents described above.)
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4.2 Using Adobe Acrobat

■ Rotating the page view of a PDF file

Even after scanning a document and saving it as a PDF file, you can change the page view 
orientation of this PDF file with Adobe Acrobat.
When the [Allow automatic image rotation] function (page 100) fails to correct the orientation of a 
page view, or you want to change the orientation of other pages, follow the procedure below.

Operation

1. With Adobe Acrobat, open the PDF file.   

2. From the menu bar, select [Document] -> [Rotate Pages].  
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3. Specify the page in which you want to change the orientation and click the [OK] but-
ton.

Direction: Specify the angle and the direction of the rotation.
Page range: Specify the page number of the pages you want to rotate.    

⇒ The orientation of the specified page(s) is (are) changed.   

HINT
For details of this function, refer to "Adobe Acrobat Help."
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■ Deleting pages from a PDF file

Unnecessary pages of a document which has been scanned and saved as a PDF file can be deleted 
with Adobe Acrobat 7.0. 
When a blank page could not be skipped with [Allow automatic blank page removal] function 
(page 97), or you want to delete another unnecessary page, follow the procedure below.

Operation

1. With Adobe Acrobat, open the PDF file targeted for deletion.

2. From the menu bar, select [Document] -> [Delete Pages]. 

3. Specify the page number of the page(s) you want to delete and click the [OK] button. 

⇒ The specified page is deleted.

HINT
For details of this function, refer to "Adobe Acrobat Help."
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■ Converting scanned images to searchable text with OCR

When you scan a document, you will get a whole image of the document including signs, letters 
and numbers. However, the system cannot recognize the image data as text. This means that you 
are not able to search the content of your document without using OCR (Optical Character 
Recognition).
You can convert such image data into searchable text data by using OCR processing ("Recognize 
Text" function) of Adobe Acrobat 7.0.

Operation

1. With Adobe Acrobat, open the PDF file for conversion.

2. Select [Document] -> [Recognize Text Using OCR] -> [Start] from the menu bar.

3. In the following window, configure the necessary settings, then click the [OK] button.

⇒ The text information is added to the image data by the "Recognize Text" function.

HINT
For color documents, in the "ScanSnap Manager - Scan and Save Settings" 
dialog box, select [Scanning] tab -> "Image quality" -> "Better (Faster)" or "Best 
(Slow)" and scan. 
For details of this function, refer to "Adobe Acrobat 7.0 Help."
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4.3 Scanning Business Cards

A ScanSnap product comes with "CardMinder", an application software for managing business 
card data.
Using CardMinder, you can convert business cards into image data, and create a database of 
business cards by recognizing their image data using the OCR (Optical Character Recognition) 
technology.

The following describes how to start CardMinder and how to scan business cards with it.

HINT
• For further details, refer to the "CardMinder User’s Guide." If CardMinder is 

already installed on your personal computer, you can browse the User’s Guide 
by selecting  [Start] -> [All Programs] -> [CardMinder] -> [Manual]. (You can 
also browse the User’s Guide from the "Setup CD-ROM" startup screen sup-
plied with this scanner.) 

• When "CardMinder" is selected from the [Application:] drop-down list on the 
[Application] tab, the [Save], [File option], [Paper size], and [Compression] 
tabs will not be shown.

• If ScanSnap Manager is activated after CardMinder is activated, "CardMinder" 
is automatically selected from the [Application] drop-down list on the [Applica-
tion] tab. If ScanSnap Manager is activated after CardMinder is deactivated, 
the selected application will be reset to previous one.
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■ Starting CardMinder

The following describes how to create scanned images of business cards on ScanSnap.

In this example, the [SCAN] button  on the scanner is used to scan business cards.

<Preparations>

Operation

1. Right-click the "ScanSnap Manager" icon  on the task bar, and select the 
[Settings] from the menu that is displayed.

⇒ The "Scan and Save Settings" dialog box is displayed.

HINT
Business cards can also be scanned by starting up CardMinder and clicking the 
[Scan] button at the upper left of the window.
For details, refer to the "CardMinder User’s Guide."
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2. Select "CardMinder" from the "Application" drop-down list on the [Application] tab.

⇒ Two tabs, the [Application] and [Scanning] tabs, will be displayed. 

3. Click the [OK] button.
⇒ This closes the "Scan and Save Settings" screen.

HINT
"Image quality" and "Color mode" can be changed on the [Scanning] tab. 
(Refer to "[Scanning] tab" on page 62.)
The defaults are "Best" and "Color" for the scan mode. (In this section, 
business cards are scanned using these default settings.)
When CardMinder is selected from the [Application:] drop-down list, the option 
"Excellent" in the [Image quality] field on the [Scanning] tab is not available.
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<Scanning procedure>

Operation

1. Load the business cards onto the scanner.

• Load the business cards face down.
• When you scan two or more business card, set them in piles.
• Adjust the side guides so that they contact both sides of the business cards. If there is a space 

between the business cards and the side guides, place the cards along the left side guide.

2. Press the [SCAN] button  on the scanner.
⇒  Scanning will be started. After the scanning has finished, the "CardMinder" screen is 

displayed.
 

ATTENTION
• Do not connect or disconnect other USB devices during the scanning 

operation.
• Do not close the paper chute or press the [POWER] button on the scanner 

during the scanning operation.
• Do not switch the user to log in during the scanning operation.

HINT
• As the default setting, documents are scanned at "Duplex" mode when you 

press the [SCAN] button. Using "ScanSnap Manager", you can set the 
scanner to scan documents in "Simplex" mode by pressing [SCAN] button.

• You can also start scanning with the "ScanSnap Manager" icon  on the 
task bar.

*For details, refer to "3.4 Changing Scan Settings" (on page 53).

Paper chute

Business card

Side guide

[SCAN] button
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Operation

3. Confirm the image data of the scanned business cards on the [CardMinder] main 
window. 

The image data of scanned business cards are displayed on the right.
A list of already saved business cards is displayed on the left.
Under the image data, the recognized characters are displayed.

4. Should there be any mistake of the recognition, correct the data manually.
Correct the recognized characters, if they are different from image data.

5. Select [Exit] from the [File] menu to quit CardMinder. 

 

HINT
For details on correcting recognized characters, refer to the "CardMinder 
User’s Guide." 

HINT
For further details, refer to the "CardMinder User’s Guide." If CardMinder is 
already installed on your personal computer, you can browse the User’s Guide 
by selecting [Start] -> [Programs] -> [CardMinder] -> [Manual]. (You can also 
browse the User’s Guide from the "Setup CD-ROM" startup screen supplied 
with this scanner.)

Recognition result

Data list Card image
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4.4 Using ScanSnap Organizer

ScanSnap Organizer is a software application for displaying and sorting image files such as the 
PDF and JPEG files.
Images scanned by ScanSnap can be displayed without opening, folders can be created for 
different purposes, and files can also be sorted.
This following explains how to use ScanSnap Organizer.

■ Starting ScanSnap Organizer

Operation

1. From the [Start] menu, select [All Programs] -> [ScanSnap Organizer] -> [ScanSnap
Organizer].

⇒ The ScanSnap Organizer window appears.   

   

HINT
For details, refer to "ScanSnap Organizer User’s Guide" .
If ScanSnap Organizer has already been installed, you can refer to it by select-
ing [Start] -> [All programs] -> [ScanSnap Organizer] -> [User’s Guide]. (You 
can also access the manual from the initial screen of the privided software on 
the ScanSnap Setup CD ROM.
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■ Connecting to ScanSnap

Scanning with ScanSnap, and how "ScanSnap Organizer" displays the scanned images is 
explained.

<Preparation>

Operation

1. Right-click the "ScanSnap Manager" icon  on the task bar and select "Settings"
from the menu.

⇒ The "Scan and Save Settings" screen appears.

HINT

• You can also double-click the ScanSnap Organizer icon  on 

the desktop.
• Password-protected PDF files are not thumbnailed because of security 

reasons.* These files are displayed in the form of the Adobe Acrobat 

icon along with the lock symbol  on the bottom left-hand corner.
* However, PDF files with the same password as the "fixed password" 
set on the "PDF file format option" window using ScanSnap Manager 
can be thumbnailed.
For details on how to set the fixed password, refer to "Set a password 
for PDF file" on page 70.

• If ScanSnap Manager is activated after ScanSanp Organizer is acti-
vated, [Application:] on the [Application] tab will automatically be 
switched to "ScanSnap Organizer", and if ScanSnap Manager is acti-
vated after ScanSnap Organizer is deactivated, [Application:] on the 
[Application] tab will be switched to the previously-selected application.
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2. Select "ScanSnap Organizer" from the "Application" drop-down list on the [Applica-
tion] tab.

3. Click the [OK] button.
⇒ The "Scan and Save Settings" screen closes.
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<Scanning>

Operation

1. Load the document onto the scanner.

2. Press the [SCAN] button .
⇒ Scanning is started.

When scanning is complete, "ScanSnap Organizer" starts and displays the scanned image 
as a thumbnail.

HINT
The scanned image is saved in the folder specified in [My ScanSnap Folder] on 
the [Option Settings] window. (Refer to page 124)
*The initial setting is the [My ScanSnap] folder under [My Documents].
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<Sorting Files>
How to create a new Cabinet and folder and how to move scanned files to the Cabinet and folder 
are explained here.

Operation

1. On the [File] menu, select [New] -> [Cabinet].

⇒Under [My ScanSnap] folder in Folder View, [New Cabinet] is created.

2. Enter a name for the Cabinet.
Enter the name “Investigation Report” here.

3. Select the Cabinet created in Step 1.

4. On the [File] menu, select [New] -> [Folder].
⇒Under the Cabinet created in Step 1, [New Folder] is created.

HINT
The idea is similar to arranging a big pile of documents (files) in the room ([My 
ScanSnap] folder), purchasing a new shelf (Cabinet) and a new document tray 
(folder), and classifying them according to subject to sort out the documents.
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5. Enter a Folder name.

6. Repeat Steps 4, 5 to create folders as needed.
As an example, create two folders named [July 2005] and [August 2005].

7. Select the file. 

8. Drag-and-drop the selected file to the destination folder.

9. Repeat Steps 7, 8 to store files in the destination folders.  

HINT
You can select several files at one time when you press down and hold the [Ctrl] 
key.
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4.5 Using ABBYY FineReader

Documents scanned with ScanSnap are very much like the original text, but they are essentially 
images and are not editable in Microsoft Word, Excel, and so on.
You can convert such texts into files in Microsoft® Word, Microsoft® Excel, Microsoft® Power-
Point, or PDF formats by using ABBYY FineReader.
ABBYY FineReader recognizes the scanned pages and immediately exports them into the applica-
tion of your choice.
The following section briefly explains how to use ABBYY FineReader.

■ Linking ABBYY FineReader

<Preparation>

Operation

1. Right-click the "ScanSnap Manager" icon  on the task bar and select "Settings"
from the menu.

⇒ The "Scan and Save Settings" screen appears.

HINT
For details, refer to "ABBYY FineReader for ScanSnap Help."
Select [Start] -> [All Programs] -> [ABBYY FineReader for ScanSnapTM 2.0] -> 
[User’s Guide].
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2. On the [Application] tab, select an application into which the document you scan is 
exported from the "Application" drop-down list.

For example, select ABBYY Scan2Word.

3. Click the [OK] button.
⇒ The "Scan and Save Settings" screen closes.

       

ATTENTION
• Make sure that ABBYY FineReader for ScanSanp is installed in your com-

puter.
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HINT
• ABBYY FineReader comprises four utilities: Scan2Word, Scan2Excel, and 

Scan2PowerPoint.
• You can also select the text recognition language and configure various set-

tings on the "ABBYY FineReader for ScanSnap (TM) 2.0" window.
To open the "ABBYY FineReader for ScanSnap" window, select [Start] -> [All 
Programs] -> [ABBYY FineReader for ScanSnap (TM) 2.0] -> [ABBYY 
FineReader for ScanSnap (TM) 2.0].
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<Scanning and Recognizing Documents>

Operation

1. Load the document onto the scanner.

2. Press the [SCAN] button .
⇒ Scanning is started.

When scanning is complete, ABBYY FineReader automatically starts reading images.

⇒  The scanned document is opened with Microsoft® Word.  

HINT
To get the document in a different format, select the application on the [Applica-
tion] tab and scan the document again.

⇒Select ABBYY Scan2Excel if you wish recognized text to be exprted 
into Microsoft® Excel.

⇒Select ABBYY Scan2PowerPoint if you wish recognized text to be 
exported into Microsoft® PowerPoint.
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Chapter 5
5

Troubleshooting

This chapter describes how to remove jammed documents and resolve other issues. 
5.1 Clearing Document Jams................................................................................... 136

5.2 Troubleshooting Checklist................................................................................. 138
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5.1 Clearing Document Jams

If a paper jam occurs during scanning, follow the procedure below to remove the jammed docu-
ment.

CAUTION

• Open the ADF before removing the jammed document.
• Be careful when removing the jammed document.
• When removing the jammed document, be careful not to get neckties or necklaces entan-

gled in the scanner.
• The surface of the ADF glass becomes hot during operation. Take care not to get burned. 

Operation

1. Remove the document on the paper chute.

2. Open the ADF while pulling the cover open lever. 

HINT
Clean the ADF by following the guidelines in "6.3 Cleaning the Inside of the 
Scanner" (page 148). 

Paper chute

Cover open lever

ADF
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3. Remove the jammed document.

4. Close the ADF.

⇒You should hear the ADF click when it returns to its original position. 

ATTENTION
Make sure that the ADF is completely closed. Otherwise, paper jams or other 
feeding errors may occur.

Paper chute

ADF
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5.2 Troubleshooting Checklist

This section describes common problems that may occur during the usage of ScanSnap and how to 
resolve them.
Before you request repair service, check the following list.
If you cannot solve the problem after checking the following list, contact an authorized FUJITSU 
scanner service provider. 

  Symptom Check This Item Resolution

The scanner cannot be 
turned on. 

Is the AC/USB cable and 
the AC adapter connected 
correctly?

Correctly connect the AC/USB cable 
and AC adapter.

Disconnect and then re-connect the 
AC cable and AC adapter.
(* Wait at least 5 seconds before 
reconnecting the AC cable)

Is the paper chute closed? 
(The scanner’s power is 
controlled by closing/open-
ing the paper chute.)

Open the paper chute.

Is Windows normally 
started up?
(This scanner’s power is 
controlled by turning on/off 
the computer.)

Wait until Windows has started up 
completely.  LED will turn off 
when Windows is starting up or in 
the sleeping mode.

Did you push the [POWER] 
button to turn off the scan-
ner? (The scanner can be 
turned off by pressing 
[POWER] button when the 
paper chute is opened.)

Press the [POWER] button.
138



5.2 Troubleshooting Checklist

Troubleshooting

5

Scanning does not start. Is the USB cable con-
nected correctly?

Connect the USB cable correctly. 
(When a hub is used, check the 
hub’s power supply.) 

Does the  LED light 
blink repeatedly?

Disconnect and then re-connect the 
AC cable and AC adapter.
(* Wait at least 5 seconds before 
reconnecting the AC or USB cable)

Is ScanSnap Manager 
started? 
(If ScanSnap Manager is 
started up successfully, the 
"ScanSnap Manager" icon 

 appears on the task 
bar.) 

If the "ScanSnap Manager" icon is 
not displayed, select [Start] -> [All 
Programs] -> [SnanSnap Manager]
-> [ScanSnap Manager] to start 
ScanSnap Manager.

Is ScanSnap Manager run-
ning normally?
(If ScanSnap Manager is 
not running normally, the 
"ScanSnap Manager" icon 
in the task bar is displayed 

as .)

Do the following:
1. Perform "Scan for hardware 

changes" or "Refresh" from 
Device Manager.(*1)

If the situation does not improve, 
perform step 2.

2. Disconnect and re-connect the 
AC cable and AC adapter (Wait 
at least 5 seconds before turning 
on the power again). 

If this does not improve the situa-
tion, perform step 3.

3. If a USB hub is in use, directly 
connect ScanSnap to your PC. If 
this does not improve the situa-
tion, perform step 4.

4. If your PC has multiple USB 
ports, connect ScanSnap with 
another port. If this does not 
improve the situation, perform 
step 5.

5. Restart your PC.
If none of the above operations 
resolves the problem, uninstall 
and re-install ScanSnap Manager 
by following the procedure given 
at (*2).

Is the "Scan and Save Set-
tings" window still dis-
played?

Close the "Scan and Save Settings" 
window, and scan the document. 

Vertical lines appear in 
the scanned image.

Is the inside of the ADF 
dirty?

Clean the inside of the ADF following 
the instructions in Chapter "6 Daily 
Care" (page 145). 

  Symptom Check This Item Resolution
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The scanned image 
shifts or is distorted.

Is the document loaded 
correctly?

Load the document correctly follow-
ing the instruction in "3.3 Loading 
Documents" (page 39)

The image scanned is 
too light or too dark.

Is the "Brightness (Black 
and White scanning only)" 
setting on [Option] of the 
[Scanning] tab set to 
extremely Light or Dark?

Adjust "Brightness" at [Scanning] - 
[Option] in the "Scan and Save Set-
tings" window.

Lines on the document 
are blurred.
(Example: Ruled lines 
on a table cannot be 
seen.)

Are you scanning in color 
mode, documents includ-
ing handwritten or typed 
text, tables or frames with 
ruled lines?

The color mode is used for capturing 
colored images like photos in high 
quality. For other documents includ-
ing textual content, select the check-
box for [Setting for text only 
document] at [Scanning] – [Option] 
in the “Scan and Save Settings” win-
dow.
If it does not improve even after you 
have tried this method, change 
"Image quality" setting.

The scanning speed is 
very slow.

Does your PC meet the 
recommended system 
requirements?

Confirm the system requirements in 
" Before Installing ScanSnap" (page 
6).
Scanning speed will be slower 
whenever the recommended CPU 
and memory requirements are not 
met. 
If this is the case, at [Scanning] - 
[Option] in the "Scan and Save Set-
tings" window, clear the checkboxes 
of the following to increase the scan-
ning speed.
• Correct skewed character strings 

automatically
• Allow automatic image rotation

Is the USB 1.1 connected?

Note: When using an 
USB1.1 interface, the data 
transfer rate may be 
slower due to large data 
sizes.

If your PC has an USB 2.0 port, con-
nect the scanner to this port. (If 
using a USB hub, it must also sup-
port USB 2.0 interfaces.) (*3)

Multi-feeds (*4) occur 
frequently. 

Is the Pad ASSY dirty? Clean the pad by following the 
instructions in "6.3 Cleaning the 
Inside of the Scanner" (page 148). 

Is the Pad ASSY worn? Clean the Pad ASSY by following 
the instructions in "7.2 Replacing the 
Pad ASSY" (page 156). 

Is the document stack 
thicker than 5mm? 

Reduce the number of sheets in the 
document stack to 5 mm thickness 
or less. 

  Symptom Check This Item Resolution
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Paper is not fed (stops 
midway). 

Is the Pick roller dirty? Clean the Pick roller by following the 
instructions in "6.3 Cleaning the 
Inside of the Scanner" (page 148). 

Is the Pick roller worn out? Clean the Pick roller by following the 
instructions in "7.3 Replacing the 
Pick Roller" (page 159). 

Are there any debris on the 
document feeding path? 

Remove any debris from the docu-
ment feeding path. (Refer to "5.1 
Clearing Document Jams" (page 
136). 

Do the loaded documents 
satisfy the conditions 
described in section "3.2 
Scanning Different Docu-
ment Types" (page 36)?
If not, they might not pass 
smoothly through the ADF.

Try the following:
• Slightly push through with your 

finger the first sheet of the docu-
ments at the start of scanning.

• Change the insertion direction of 
the document.

The scanner is not 
recognized even if 
ScanSnap Manager is 
installed.

Did you connect the scan-
ner to your PC before 
installing ScanSnap Man-
ager?
Is the scanner registered 
as "Other device" in the 
"Device Manager"?

On the [Start] menu, select [Control 
panel] -> [System] -> [Hardware] -> 
[Device Manager].
Delete the device name such as USB 
device (differs with the OS) under 
"Other Device" selection in the 
[Device Manager] and restart your 
PC.

The file size of a 
scanned black & white 
image is the same as for 
a color document. 

Is the B&W document 
scanned in the color 
mode?

Select "B&W" from the [Color mode] 
drop-down list on the [Scanning] tab 
in the "Scan and Save Settings" win-
dow. 

Images on the back of 
pages, which are 
printed-through, are 
overlaid on the scanned 
image when scanning a 
two-sided document. 
(This is called "noise" of 
the back side image.)

Is the "Setting for text only 
document" checkbox 
cleared in the [Read mode 
option] window ([Option] 
on the [Scanning] tab of 
the "Scan and Save Set-
tings" window)?

Mark the "Setting for text only docu-
ment" checkbox. (Available only in 
color mode) Marking it makes char-
acters, lines, and contrasts sharper 
and clearer, and removes the noise 
of the back side image. Note that 
you can also use this mode for docu-
ments including photos and illustra-
tions. Even if this mode is used, the 
contrasts and colors might be 
affected. 

Scanned images are not 
displayed on the screen 
(when"Allow automatic 
blank page removal" is 
enabled).

When "Allow automatic 
blank page removal" is 
enabled, almost blank 
documents with only a 
few characters may be 
accidentally recognized 
as blank pages and 
removed from scanned 
image data.

Right-click "ScanSnap Manager" 
icon on the task bar, select [Setting] 
-> [Scanning] tab and click the 
[Option] button. Then clear the 
"Allow automatic blank page 
removal" checkbox.

  Symptom Check This Item Resolution
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Scanned images are 
skewed.

Are the documents fed into 
the ADF with a skew of 
more than +/-5 degrees?

The "Correct skewed character 
strings automatically" function can 
correct skewed images up to +/-5 
degrees. Load the document onto 
the scanner so that the document 
skew does not exceed this limit.

Depending on the contents 
of document, the automatic 
image deskew may not 
work properly.

Refer to " Correct skewed character 
strings automatically." (page 65)

The orientation of 
scanned images is not 
displayed correctly 
(when "Allow automatic 
image rotation" is 
enabled).

Depending on the contents 
of document, the automatic 
image rotation may not 
work properly.

Refer to " Allow automatic image 
rotation." (page 67)

The scanned images 
cannot be read. 

Have you scanned docu-
ments written in small let-
ters?

When small letters are squashed, 
right click "ScanSnap Manager" icon 
on the task bar and select Excellent 
in the [Scanning] tab and scan them 
again. 

A part of the document 
does not appear in the 
scanned image.

Is the “Allow automatic 
blank page removal" 
enabled?

Clear the check box for “Allow auto-
matic blank page removal" on 
[Option] of the [Scanning] tab of 
[Scan and Save Settings]

The document is not fed 
properly or gets 
jammed.

1. Is the inside of the scan-
ner dirty?
2. Are you scanning one of 
the following?
    Thin paper
    Torn paper
    Folded paper

1.Clean the dirty locations.
2.Use the Carrier Sheet for each 
page if you have difficulties feeding 
the document.

When the document is 
scanned with Carrier 
Sheet, a message, 
"Document size incor-
rect", appears.

Did you put multiple small-
size materials (pictures/
post cards) in Carrier 
Sheet for scanning?

Put only one small-size material (pic-
tures/post cards) in Carrier Sheet 
per scanning.

When the document is 
scanned with Carrier 
Sheet, a paper jam 
occurs frequently.

----

Feed about 50 sheets of PPC paper 
or recycled paper, and then scan the 
document by using Carrier Sheet.
* You can use either unused or used 
PPC/recycled paper.

Black lines are pro-
duced on the scanned 
document.

Is the scanned documents 
written with a pencil?

It is recommended to use Carrier 
Sheet for scanning.
If you are not using Carrier Sheet for 
scanning such documents, clean 
rollers as often as possible.
For information about how to clean 
rollers, refer to "6.2 Cleaning the 
Scanner Exterior" (page 147).

  Symptom Check This Item Resolution
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5.2 Troubleshooting Checklist

Troubleshooting

5

(*1) For Windows XP, in the "Device Manager" window, right-click on the computer name and
 perform "Scan for hardware changes."

(*2) - Make sure the personal computer and ScanSnap are powered on and connected properly.
- In the "Device Manager" window, check if ScanSnap is recognized as unknown device.

        If so, go to [Control Panel] -> [System] and delete it.
- Close ScanSnap Manager
- Go to [Control Panel], select [Add or Remove Programs], and uninstall ScanSnap Manager

        and ScanSnap Organizer. Refer to "Appendix B - Uninstalling Supplied Programs (page 
169)."

- Before restarting the personal computer, remove the following folders:   

          For Windows 2000, Windows XP:

          Delete the folder ScanSnap under: 
⇒       c:\Documents and Settings\<User name>\Application Data\PFU\

          Delete the folder Driver under: 
⇒      c:Program Files\PFU\ScanSnap\                  

          For Windows 98, Windows ME:

          Delete the folder Driver under: 
⇒       c:\Program Files\PFU\ScanSnap\

After you have removed the folders, check if the files
     

The scanned image is 
chipped/Slant lines are 
produced on the 
scanned image/The out-
put image is wider than 
the original. 

With "Automatic detection" 
being selected in the 
"Paper size" drop-down 
list, was the document 
skewed during a scan? 

Neatly align the edges of paper 
sheets with Side Guide.
* If you are scanning documents of 
mixed paper sizes, marking the 
"Scan mixed paper size" checkbox 
(page 101), carefully load smaller 
documents so that they can be fed 
straight.
If those documents cannot be fed 
straight, it is recommended to scan 
only documents of about the same 
size at a time. 

ATTENTION
After the uninstallation of ScanSnap Manager, delete the following folders and 
files before restarting your computer.

Pay extra attention not to remove any other folders or files, since this will affect 
your system environment.

  Symptom Check This Item Resolution
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                          -  fi5110e.inf
                          -  fi5110e.PNF 

in the folder C:\Windows\Inf have been deleted. If the files still exist, remove these two files.

       - After the folders and files are removed, restart your computer with ScanSnap disconnected.
       - Reinstall ScanSnap Manager and restart.

(*3): To confirm whether the scanner is connected with USB1.1 or USB2.0, right-click ScanSnap 
icon on the task. Select [Help] -> [About ScanSnap Manager], and then click [Detail] button 
on [Version Information] window. [USB type] is displayed.

(*4): "Multi-feed" is a phenomenon where two or more sheets are fed into the scanner together.

*  Useful information will be provided on the FAQ Corner. For further information, please visit our 
website at:  http://scansnap.fujitsu.com

HINT
Note: The folder C:\Windows\Inf may be hidden. To check these two files and 
remove them, select [Explorer] -> [Tools] -> [Folder Options]. In the [View] tab, 
check if the checkbox of [Show hidden files and folders] under [Hidden files and 
folders] is marked. After this checkbox is marked and the setting is applied, the 
hidden C:\Windows\Inf folder becomes visible. Check if the fi5110e.inf and 
fi5110e.PNF files exist. If they do, remove them. 
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Chapter 6
6

Daily Care

This chapter describes how to clean ScanSnap.

WARNING

Fire/Electric Shock
Before you clean the scanner, turn off the scanner and dis-
connect the AC adapter from the power outlet. 
6.1 Cleaning Materials .............................................................................................. 146

6.2 Cleaning the Scanner Exterior........................................................................... 147

6.3 Cleaning the Inside of the Scanner ................................................................... 148

6.4 Cleaning Carrier Sheet ....................................................................................... 151
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6.1 Cleaning Materials

*1) To purchase cleaning materials, contact the FUJITSU scanner dealer where you pur-
chased the scanner.

*2) Any lint-free cloth can be used.

Cleaning Materials Parts No. Remarks

Cleaner F1 CA99501-0013 1 bottle (100ml)
Moisten a cloth with this fluid 
and wipe the scanner clean.
(*1)

Lint-free dry cloth Commercially available. (*2)
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6.2 Cleaning the Scanner Exterior
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6.2 Cleaning the Scanner Exterior

Clean the scanner exterior and the ADF paper chute with a cloth moistened with a small amount of 
Cleaner F1 or any neutral detergent. 

ATTENTION
• Never use paint thinner and other organic solvents.
• During the cleaning, prevent water or moisture from getting inside the scanner.
• Do not use aerosol sprays to clean the scanner. Aerosol sprays cause dirt and 

dust to enter the scanner, resulting scanner failure and malfunction.

Cloth

Cleaner F1 or 
neutral detergent

Paint thinner
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6.3 Cleaning the Inside of the Scanner

Clean inside of the scanner with a cloth moistened with Cleaner F1.
In an alternating succession of scanning documents, the accumulated paper-powder and dust inside
the scanner causes a scanning error.
As a guideline, clean the ADF every 1,000 scans. Note that this guideline varies according to the 
type of the documents you are scanning. For example, the ADF must be cleaned more frequently 
when scanning documents on that the toner has not been sufficiently fixed on. 
Clean the ADF according to the following procedure and refer to the illustrations on the following 
page. 

CAUTION

The glass surface inside the ADF becomes hot during the scanner operation.
Before you start to clean the inside of the scanner, disconnect the AC adapter from the outlet 
and wait at least 15 minutes to let the scanner cool down.

1. Open the ADF while pulling the cover open lever. 

ATTENTION
• Do not use water or neutral detergent to clean the inside of the scanner.
• Do not use aerosol sprays to clean the scanner. Aerosol sprays cause dirt and 

dust to enter the scanner, resulting scanner failure and malfunction.

ADF cover

Cover open lever

Paper chute
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6.3 Cleaning the Inside of the Scanner
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2. Clean the following locations with a cloth moistened with cleaner F1.

Turn off the scanner before cleaning the following locations.

• Pad ASSY (x 1)
Wipe the Pad ASSY downwards. When cleaning the Pad ASSY, take care to prevent the 
cloth from catching on the metal parts.

• ADF glass surfaces (x 2 located on the ADF cover and the opposite side)
Clean lightly.

• Pick roller (x 1)
Clean lightly taking care not to scratch the surface of the roller. Take particular care in 
cleaning the Pick roller since black debris on the roller adversely affect the pickup perfor-
mance.

• Plastic rollers (x4 on the ADF cover)
Clean them lightly while rotating the rollers with your finger. Be careful not to roughen the 
surface of the rollers. Take particular care in cleaning the plastic rollers since black debris 
on the rollers adversely affect the pickup performance.

Pad ASSY

Plastic roller

Pick roller

Feed roller

Glass
Eject roller
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Turn on the scanner before cleaning the following locations, and clean the following rollers 
while rotating them.

• Feed rollers (x 2)
Clean lightly taking care not to roughen the surface of the rollers. Take particular care in 
cleaning the feed rollers since black debris on the rollers adversely affect the pickup perfor-
mance. 

• Eject rollers (x 2)
Clean lightly taking care not to roughen the surface of the rollers. 
Take particular care in cleaning the eject rollers since black debris on the rollers adversely 
affect the pickup performance.
To rotate the feed rollers and the eject rollers, press the [POWER] button while holding 
down the [SCAN] button.
As a guideline, six presses of the [POWER] button make the rollers to rotate one full turn.

3. Close the ADF.

ATTENTION
Connect the AC adapter and AC cable only when cleaning the feed rollers and 
eject rollers.

ATTENTION
After closing the ADF, make sure that it is completely closed. Otherwise, paper 
jams or other feeding errors may occur.

1. Hold down the [SCAN] button.

2. Press the [POWER] button
while holding down the [SCAN]
button.

⇒ The rollers rotate.

Paper chute
ADF cover
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6.4 Cleaning Carrier Sheet
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6.4 Cleaning Carrier Sheet

If the Carrier Sheet is used extensively, dirt and dust may stick onto the surface or the 
interior and cause scanning errors. Clean it regularly to avoid errors.

Cleaning method
Use dry, soft cloth, or soft cloth slightly moistened with Cleaner F1 (sold separately) or a mild
detergent to lightly clean off the dirt and dust from the surface and the interior of the Carrier Sheet.

ATTENTION
• Never use paint thinner or other organic solvents.
• Do not rub the Carrier Sheet too hard. Otherwise, it may be scratched or be 

deformed.
• After cleaning the interior of the Carrier Sheet with Cleaner F1 or mild deter-

gent, dry the Carrier Sheet completely before closing it.
• As a guideline, it is recommended to replace the Carrier Sheet with new one 

every 500 scans.
Refer to "7.4 Purchasing Carrier Sheet" (page. 166) for details on the pur-
chase of an Carrier Sheet.
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Chapter 7
7
Replacing Consumables and Carrier 
Sheet

This chapter describes how to replace consumables.

WARNING

Fire/Electric Shock

Before you replace the consumables, turn off the scanner and disconnect the AC adapter 
from the power outlet.
7.1 Replacing Consumables .................................................................................... 154

7.2 Replacing the Pad ASSY .................................................................................... 156

7.3 Replacing the Pick Roller................................................................................... 159

7.4 Purchasing the Carrier Sheet ............................................................................ 166
ScanSnap S500 Operator's Guide 153



7.1 Replacing Consumables

This section describes how to replace consumables. 

■ Part Nos. and Replacement Cycle of Consumables

The following tables list the part numbers of consumables and rough guidelines for replacing these 
parts. 

These replacement cycles are rough guidelines for the case of using A4/Letter wood-free paper 64
g/m2 (17 lb). So it may differ according to the paper being used.
Use only the consumables specified by PFU LIMITED. Do not use consumables and parts made by
other manufacturers.

No. Description P/N Standard Replacement 
Cycle

1  Pad ASSY PA03360-0002 50,000 sheets or one year

2  Pick roller PA03360-0001 100,000 sheets or one year
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7.1 Replacing Consumables
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HINT

By the following procedure, you can create a rough guideline for replacing con-
sumables and for estimating how many sheets have been already scanned.

1. Right-click the "ScanSnap Manager" icon on the task bar.
2. Click [Check consumable supplies] at the menu.

⇒ The screen ("Check consumable status" screen) is displayed. This screen 
indicates how many times consumables have been used.

Replace consumables referring to "Target value to change supplies" as a rough 
guideline.
For details about purchasing consumables, visit the following website or con-
tact the Fujitsu scanner dealer where you purchased your scanner.
[Website] http://scansnap.fujitsu.com/
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7.2 Replacing the Pad ASSY

Replace the Pad ASSY following the procedure below.
Operation

1. Remove the documents on the paper chute.

2. Open the ADF while pulling the cover open lever.

3. Remove the Pad ASSY. 
Pull out the Pad ASSY in the direction of the arrow while pinching both ends of the Pad 
ASSY.

    ADF

Cover open lever

Paper chute

ADF 

Pad ASSY
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7.2 Replacing the Pad ASSY
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4. Attach the new Pad ASSY.

5. Close the ADF.

⇒You should hear the ADF click when it returns to its original position.

ATTENTION

Make sure that the Pad ASSY is completely attached. Otherwise, document 
jams or other feeding errors may occur.

Pad ASSY

     ADF

Paper chute

       ADF
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6. Turn on the scanner.

7. Right-click the "ScanSnap Manager" icon on the task bar, and select [Check consum-
able supplies] from the menu.

⇒ This displays the "Check consumable status" window.

8. In the "Check consumable status" window, click the [Reset] button of Pad ASSY 
Count.

⇒ The counter is reset to "0."
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7.3 Replacing the Pick Roller
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7.3 Replacing the Pick Roller

Replace the Pick roller following the procedure below.

1. Remove the documents on the paper chute.

2. Open the ADF while pulling the cover open lever.

3. Adjust the Side guide to the "A5" size.

 

        ADF

Cover open lever

Paper chute

A5A5
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4. Remove the sheet guide.
Pinch the knobs on the sheet guide and pull the sheet guide to remove it.

5. Rotate the pick roller bushing (left).

Handle

Sheet guide

Claw

Pick roller bushingPick roller Pick roller shaft
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7.3 Replacing the Pick Roller
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6. Remove the pick roller with its shaft.
Slightly pull up the left part of the Pick roller shaft (about 5mm), move it towards the left 
side, and then raise it to remove from the scanner.

7. Remove the pick roller from its shaft.
Pull out the shaft from the pick roller while lifting up its tab.

ATTENTION

If the around the pick roller is dirty by paper-powder, it may cause a scanning 
error. Remove the dirt using a dry cloth with dollop of Cleaner F1.
* Don't use water, mild detergent or air-spray.

Pick roller shaft
Pick roller

Shaft

Tab

Pick roller
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8. Attach the new pick roller to the shaft.
Insert the shaft aligning the protrusion with the slot on the new pick roller.

9. Install the pick roller with it’s shaft to the scanner.
Insert the right end of the shaft to the roller bushing (right), and set the shaft to the slot while 
lowering it.

ATTENTION

If you push up the pick roller tab using your fingernail, your fingernail may be 
hurt or get chipped. If you cannot push it up successfully with your fingernail, 
use a paper clip to push up the pick roller tab.

1

2

Shaft

Protrusion

Pick roller

Slot

Pick roller
Pick roller shaft
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7.3 Replacing the Pick Roller
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10. Rotate the roller bushing (left) by rotating it in the direction of the arrow.

11. Attach the sheet guide to the scanner.
Pinch the knobs on the sheet guide and attach it to the scanner.

ATTENTION

Make sure that the Pick roller is completely attached. Otherwise, document 
jams or other feeding errors may occur.

Pick roller Pick roller shaftPick roller bushing

Handle

Sheet guide
Craw
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⇒ The sheet guide makes a clicking sound when the knobs fix into position.

12. Close the ADF.

⇒You should hear the ADF click when it returns to its original position. 

13. Turn on the scanner.

14. Right-click the "ScanSnap Manager" icon in the task bar, and select [Check consum-
able supplies] from the menu.

⇒ This displays the "Check consumable status" window.

ATTENTION

Make sure that the sheet guide is completely attached. Otherwise, document 
jams or other feeding errors may occur.

Paper chute

          ADF
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7.3 Replacing the Pick Roller
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15. In the "Check consumable status" window, click the [Reset] button of the consumable 
you replaced.

⇒ The counter is reset to "0."
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7.4 Purchasing the Carrier Sheet

If the “Carrier Sheet” bundled in this product cannot be used for scanning due to damage or wear-
and-tear, you can purchase just the Carrier Sheet separately.

As a guideline, it is recommended to replace the Carrier Sheet every 500 scans.
However, it differs according to usage. If scratches and dirt are conspicuous, replace the Carrier
Sheet accordingly.
The description of the Carrier Sheet (also sold separately) and part number are as follows:

Description Qty P/N

ScanSnap Carrier Sheet 5 pcs FI-511ES-WW
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Appendix A 
A

Updating ScanSnap Manager
In an effort to improve the usability and functionality of ScanSnap Manager, program updates are 
carried out timely.
ScanSnap Manager can automatically detect whether the latest program (Update Pack) is 
available and update the program.

When updating ScanSnap Manager, follow the instructions below.

Operation

1. Right-click the "ScanSnap Manager" icon  and select [Help] - [Online Update].

⇒A confirmation message appears for the update.

HINT
Update Packs are made available without notice. We recommend that you 
update your program regularly.

ATTENTION
• When updating, it is essential that Internet Explorer is installed in a system 

which can access the Internet.
• For Windows XP or Windows 2000, you must log on as an administrator.

SS
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2. Click the [Yes] button.

⇒ If the latest Update program is available, a message appears for the confirmation of the 
download and installation of the program.

3. Click the [Yes] button.

⇒ The program is downloaded, and a confirmation message to start installation appears.

4. Click the [Install] button.

⇒ Installation starts, and the “Welcome to InstallShield Wizard for ScanSnap Manager” 
window appears.
Follow the instructions on the screen to install.

HINT
If the latest update is already installed, an informational message appears.

Click the [OK] button to close the message.

HINT
When you click the [Info] button, Internet Explorer opens and information about 
the latest update for ScanSnap Manager appears.
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Appendix B 
B

Uninstalling ScanSnap
"Uninstallation" removes the ScanSnap program files that were copied during the installation from 
the hard disk and restores the system environment to its original state. 
This chapter describes how to uninstall ScanSnap.

■ Uninstalling Supplied Programs 

Follow the procedure below to uninstall programs (ScanSnap Manager, CardMinder, and Scan-
Snap Organizer) supplied with ScanSnap.

1. Start up your PC.

When using Windows 2000 or Windows XP, log in as a user with "Administrator" privileges 
(computer administrator privileges in the case of Microsoft Windows XP Home Edition 
operation system).

2. Exit all currently running programs. 

3. Select [Control Panel] -> [Add or Remove Programs] from the [Start] menu.
⇒ The "Add or Remove Programs" screen appears with a list of the currently installed 

applications.

4. Select the application to uninstall.
(1) When uninstalling ScanSnap Manager

Select "ScanSnap Manager."
(2) When uninstalling CardMinder

Select "CardMinder V3.0."
(3) When uninstalling ScanSnap Organizer

Select "ScanSnap Organizer."

5. Click the [Change/Remove] button.
⇒ The "Confirm Uninstall" window appears.

6. Click the [OK] button.
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⇒ This executes the uninstallation. 

7. After the uninstallation is completed, select "Yes, I want to restart my computer now!" 
and click the [Finish] button. 

ATTENTION
Screen displays may vary slightly depending on the operating system (OS) of 
you personal computer. Follow the on-screen instructions of the OS.

Example: When the OS is Windows 2000
• "Add or Remove Programs" −>   "Add/Remove Applications"
• [Change/Remove] button −>   [Add/Remove] button
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Appendix C 
C

Installation Specifications
The following table summarizes the installation specifications of this scanner.

Note) Dimensions

Item Specifications

Dimensions 
(Note)

Width Depth Height

Minimum 284 mm
11.18 in.

159.2 mm
6.27 in.

147 mm
5.79 in.

Maximum 284 mm
11.18 in.

436.7 mm
17.19 in.

299.5 mm
11.79 in.

Weight 2.7 kg   (approximately 5.95 lb)

Input power 
supply

Voltage 100 - 240 V

Number of 
phases

Single-phase

Frequency 50/60 Hz

Power con-
sumption

During 
operation

28 W or less

During standby 6 W or less

Temperature/
Humidity
Allowable 
Ranges

Scanner state During operation During standby During storage/
transportation

Temperature 5 to 35 (°C)
41 to 95 (°F)

-20 to 60(°C)
-4 to140 (°F)

-20 to 60(°C)
-4 to 140 (°F)

Humidity (%) 20-80 8-95 8-95
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Repairs
Contact the store where you purchased your ScanSnap or an authorized service provider for per-
forming repairs on this product.

• The user must not perform any repairs on the scanner.
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